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1 Welcome to Metrel ES Manager Help 

 
Use the Bookmarks on the left side of the window to select or search for a topic. You can 
also select one of the following Quick links to start learning about ES Manager. 

 
 

➢ Introduction 

➢ Online support information 

➢ End-User Licence Agreement 

➢ Getting started 
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2 Introduction to Metrel ES Manager 

2.1 What is Metrel ES Manager? 

Metrel Electrical Safety Manager new 

generation instruments. The wide palette of Metrel's electrical safety testers, portable appliance testers, 

machine testers and industrial safety testers can be managed by one single application. Together with the new 

it forms a unified user interface  same view, same meaning. 

The Metrel ES Manager enables pre-treatment of test an object structure and related measurements on the PC, 

uploading to the instrument, downloading of finished test results to the PC, viewing, editing archiving, 

generation and printing of various professional test reports. 

Depending on the model or type of the target instrument, the user can create custom Auto Sequence® 

measurement tests and custom inspection tests. Auto Sequences® and also single tests, can be integrated into 

the custom created test object structures and then uploaded into the measurement instrument. 

Professional reports are based on predefined templates according to the national standards or the rules of 

regulatory organisations where the user enters all the needed protocol data while the measurement results are 

automatically inserted into the predefined forms. 

 

Functionality of the Metrel ES Manager  PC software program depends on the licence key, which is always 

related to the serial number of the purchased instrument: 

• BASIC licence 

• PRO licence 

In case of a new generation Metrel tester, the license key is stored in the instrument itself thus enabling the 

user to prepare professional report on any PC without the need of inserting the license. 

Reports based on predefined templates according to the national standards or the rules of regulatory 

organisations are available with PRO licence only. 

2.1.1 User Interface 

 

Figure 2.1: Main Window View 
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User interface main features: 

 
• The Main window interface presentation fields organization allow quick selection of structure 

elements and test data using a Windows Explorer-like Tree View 

 
• Properties of selected structure elements and test data are instantly displayed in multiple 

presentation fields of the Main window 

 
• By dragging, docking and resizing the presentation fields of the Main window, the working 

environment may be customized in numerous ways 

2.1.2 Connectivity 

• Supports multiple Work Scopes simultaneously for electrical safety testers, portable appliance 

testers, machine testers and industrial safety testers 

 
• USB and RS-232 serial data communication is supported 

 

                        

 

 
 
 
 
 
 
 
 

 
 
 
 

Note 
Please note that some parts of program can be changed without 

notice in new software versions, and therefore might differ from the 

information in this manual. If you encounter such differences, we will 

gladly accept your e-mail with your suggestions and include or change the 

necessary information in our next hotfix or update. 
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3 End-User Licence Agreement 

3.1 Important Notice 

Read this License Agreement carefully before using this Software. BY USING THIS SOFTWARE IN ANY 

WAY, YOU ACKNOWLEDGE THAT YOU HAVE READ, UNDERSTOOD, AND AGREED TO THE TERMS OF THIS 

AGREEMENT. IF YOU DO NOT AGREE TO THESE TERMS, DO NOT USE THIS SOFTWARE IN ANY WAY, AND 

PROMPTLY RETURN IT OR DELETE ANY COPIES OF THIS SOFTWARE IN YOUR POSSESSION. 

3.1.1 Licence grant 

 

By installing the software Metrel ES Manager (hereinafter "the Software" or "Software"), you are accepting the 

following License Agreement. 

 

LICENSE AGREEMENT 

This is a legal agreement between You (either an individual or an entity) and Metrel d.o.o. By installing the 

software or using it in any way you are agreeing to be bound by the terms of this agreement (hereinafter 

 If you do not agree to the terms of this agreement do not install or use the Software in any 

way. 

 

1. GRANT OF LICENSE. Metrel d.o.o. grants to You (including your employees and subcontractors) a 

revocable, non-exclusive and limited License to make and use copies of the Software strictly in 

accordance with the terms and conditions of this Agreement. The rights granted under this Agreement 

are only effective upon payment of the License fees. The Software is licensed, not sold. The Software, 

its documentation and other intellectual property related to it are owned by Metrel d.o.o. and protected 

by the international copyright laws. Metrel grants You the License to: 

a. Install and run the software on a single or multiple computers used to connect to Metrel 

a separately purchased License. 

b. Make one copy of the Software solely for backup or archival purposes. 

c. Transfer the Software to a single hard disk provided you keep the original solely for backup or 

archival purposes.  

d. You may store or install a copy of the Software on a storage device, such as a network server, 

used only to install or run the Software on other computers over an internal network; however, 

you must purchase and dedicate a License for each separate computer on which the Software 

is installed or run from the storage device. A License for the Software may not be shared or 

used concurrently on different computers. 

 

2. RESTRICTIONS OF USE. You shall use the Software in accordance with the terms of this Agreement and 

you shall not: 

a. Decompile, reverse engineer, disassemble, attempt to derive the source code for or decrypt the 

Software. 

b. Make any modification, adaptation, improvement, enhancement, derivative or translation of 

the Software. 

c. Violate any applicable law, rule or regulation in connection to your access to the Software. 

d. Remove, obscure or alter any proprietary notice (including copyright) of Metrel d.o.o. or its 

partners, except in reports where changing the default logo is specifically enabled by the 

 

e. Use the Software for any application it is not designed and intended for. 

f. Use the Software to create a product, service or software that is (directly or indirectly) in 

competition or a substitute for any offered by Metrel d.o.o. 
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g. Use the Software to send automated queries to any website or to send any unsolicited 

commercial messages. 

h. Use any proprietary information, user interfaces or other intellectual property of Metrel d.o.o. 

in the design, development, manufacture, licencing or distribution of any new software, 

accessory or device. 

3. TERMINATION. This Agreement remains effective from Your implicit or explicit agreement to it until 

termination. It will immediately terminate upon notice if You exceed the scope of License granted or 

otherwise fail to comply to this Agreement. You may terminate this Agreement by uninstalling the 

Software, returning all purchased License keys and ceasing the use of the Software and its 

documentation. 

 

4. NO WARRANTY. EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS 

PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, EITHER 

EXPRESS OR IMPLIED INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OR CONDITIONS OF 

TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Each 

recipient is solely responsible for determining the appropriateness of using and distributing the 

software and assumes all risks associated with its exercise of rights under this Agreement, including but 

not limited to the risks and costs of program errors, compliance with applicable laws, damage to or loss 

of data, programs or equipment, and unavailability or interruption of operations. 

 

5. DISCLAIMER OF LIABILITY. EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER 

RECIPIENT NOR ANY CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY DIRECT, INDIRECT, 

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT 

LIMITATION LOST PROFITS), HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 

ANY WAY OUT OF THE USE OR DISTRIBUTION OF THE PROGRAM OR THE EXERCISE OF ANY RIGHTS 

GRANTED HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

 

6. COPYRIGHT. Any and all trademarks or service marks that Metrel d.o.o.uses in connection with the 

Software or with services rendered by Metrel d.o.o., are marks owned by Metrel d.o.o.This Agreement 

does not grant you any right, license, or interest in such marks, and you shall not assert any right, 

license, or interest in such marks or any words or designs that are confusingly similar to such marks. 

 

7. PRIVACY POLICY. 

Metrel d.o.o.

accordance with GDPR. Metrel d.o.o.will comply with all applicable laws pertaining to personal data and 

metadata including GDPR. Where requested Metrel d.o.o.are prepared to enter into separate 

agreements regarding data processing 

https://www.metrel.si/en/content/privacy/android-privacy-policy.html. 

Metrel d.o.o. may (and you hereby expressly authorize Metrel d.o.o. to) disclose information about you 

to law enforcement officers, as Metrel d.o.o., in its sole discretion, deem necessary or appropriate to 

investigate or resolve possible crimes or to respond to judicial, regulatory, agency or similar inquiries. 

Metrel d.o.o. may also contact you using the information you provided to, for example, provide technical 

 

You acknowledge receipt of and agree to Metrel's privacy policy which is made available in full at 

https://www.metrel.si/en/content/privacy/android-privacy-policy.html. You hereby expressly consent 

policy as of the Effective Date, which is incorporated into this End User Agreement by reference. Metrel 

publishes a privacy policy on its https://www.metrel.si/en/content/privacy/android-privacy-

https://www.metrel.si/en/content/privacy/android-privacy-policy.html
https://www.metrel.si/en/content/privacy/android-privacy-policy.html
https://www.metrel.si/en/content/privacy/android-privacy-policy.html
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policy.html and may amend such policy from time to time in its sole discretion. You acknowledge that 

that you had the opportunity to review a more detailed explanation of how your information will be 

collected, stored and processed by Metrel in accordance with the published privacy policy of Metrel and 

that you consented to Metrel's privacy policy prior to agreeing to this Agreement. You will ensure that 

each member of your organization (including employees and contractors) about whom personal data 

may be provided to 

data. 

 

By installing the software (hereinafter "the Software" or "Software"), you are accepting the following License 

Agreement. 

 

https://www.metrel.si/en/content/privacy/android-privacy-policy.html
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4 Software Installation 

4.1 System Requirements 

Before installation, you should check that your system meets the following requirements: 

 

Supported Operating Systems:                                                                                              

 
• Windows 10, 32-bit & 64-bit 

• Windows 11, 32-bit & 64-bit 

 

 

Installed System Memory (RAM):                                                                                          

 
• Windows 10, 11: 2 GB (4 GB recommended) 

 

Hard Disk Space:                                                                                                                      
 

• At least 400 MB of free space for the installation files and documentation. 

 

• Additional 280 MB (x86) or 610 MB (x64) of free space if Microsoft.NET Framework (4.0 or higher) 

is not previously installed. 

 

• Additional disk space (20 GB recommended) is needed for downloading and saving ES Manager data 

files. 

4.2 Installing the software 

To install the software, download the application from Metrel Download centre and run the installation 
application by starting the Setup.exe. The second option is to run the installation application from the 
CD. 
The installation wizard will guide you through the language selection used during installation procedure 
and the folder location selection, where ES Manager will be installed. The default C:\Program 
Files (x86)\Metrel\MESM  is offered. Click on Browse for a user selected location if you want to change it. 
By default, Associate ES Manager with .padfx file extension  is checked. ES Manager will be started 
automatically, when a data structure file (filename.padfx) is opened from the PC file manager. By checking 
the Create a desktop shortcut, ES Manager can be started from a dedicated Desktop icon. 
 
Before the final Install command is issued, a survey of selected Metrel ES manager options is presented, 
see Figure 4.1: Survey of Metrel ES manager setup options. Click Install to continue with the installation or 
Back if you want to change the settings. 
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Figure 4.1: Survey of Metrel ES manager setup options 

:  

 

Before the installation is finished, the USB driver Installer wizard is opened, which will guide you through 
the Measurement instrument USB driver installation. Select Next to proceed with the installation. A survey 
of installed USB drivers is presented on the screen, see Figure 4.2. Select Finish to switch back to the ES 
Manager Installation wizard. Launch Metrel ES manager is checked by default, select finish to exit 
installation and start the Metrel ES manager. 
 

 

Figure 4.2: Survey of Measurement instrument USB driver installation 

 

4.3 Metrel ES Manager first use 

When the Metrel ES manager is first launched, an Instrument pairing wizard (Figure 4.3) appears on the 
screen. It will guide you to set a default work scope. Licences purchased with your Metrel instrument will 
be automatically synchronized. 
Connect your Metrel instrument to the PC and select Pair my instrument. Metrel ES Manager will 
automatically collect the instrument data and set the default work scope. 
Automatic work scope setting can be skipped and set manually at first use or any time later, when the 
instrument is connected to the PC. 
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During Instrument pairing, Metrel ES manager can find firmware upgrade for the connected instrument, if 
the PC is connected to the internet. 

 

 

Figure 4.3: Instrument pairing wizard 

4.4 Software updates 

For automatic detection of the latest Metrel ES Manager update, internet connection is needed. If a new 
version of software is detected, ES Manager will display a message with a link in the bottom right corner of 
the screen during every start-up. By clicking on it is available to download and install the latest version of 
software Metrel ES Manager. 
 

  

Figure 4.4: Update message and a link 

 
Additional access to get new software update is from the About screen. For details regarding the new 

 
 

 

Figure 4.5: About screen 
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5 Getting started 

5.1 Quick guides and tutorials 

5.1.1 Introductory Guides 

Before starting to use Metrel ES Manager, here is some information about the basic features. The following 

sections will explain the way data are organized in Metrel ES Manager and show you how to use advanced 

features and perform your work effectively. 

 

➢ Metrel ES Manager user interface Components 

➢ Creating Data Structures 

➢ Communication with Instruments 

➢ Printing Results 

➢ Creating Reports 

➢ Manage Reports 

➢ Report Templates 

➢ Troubleshooting 
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6 User Interface Components 

6.1 Introduction 

After start-up, Metrel ES Manager Welcome screen appears with Menu tabs () on the top and Home tab 

active in the working area () by default. Multiple Data structure files are supported, each opened in 

separate tab within working area. 

When connected to the internet, update status presented in bottom right corner () is automatically 

checked. 

Default Work Scope area is displayed in the bottom left corner of the window (). Check Work scope setting 

before starting a new data structure file. Failing to set the correct Work Scope will result in data upload 

failure. A new structure will have to be made from the beginning in the correct work scope in order to be able 

to upload it to the instrument. When existing data structure file is opened, Work scope is automatically set. 

 

 

Figure 6.1: Metrel ES Manager Start-up screen 

 

User options available from welcome screen Home tab working area are: 

•  : Open existing or start new data structure file 

• Demo Files: Open embedded demo data structure files from the list 

• Recent opened files: Open data file from the list 

• News: Check Metrel News 

• Videos: Watch Metrel videos on YouTube 

• : Access Metrel pages on internet social media 

6.2 Menu Tabs 

Menus are organized in tab style, Figure 6.2. Each menu tab opens a subset of functions: 

• Home menu tab is active by default, providing managing of data files, reports and communication 

with instruments, Work scope setting and access to additional tools. 

• Structure tab provides Structure elements and Measurements to build custom object structure 

test database. 

• Database tab provides Client Contacts data organization and Structure objects Name 

customization. 
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• View tab provide commands to organize view of working area; Tile vertically, Tile horizontally, 

Switch between Data structure tabs, Reset to originate view and Close all tabs  Data structure 

files. 

• Main menu tab provides Metrel ES Manager Version data and Help file. Functions provided are 

data Import, Export and merging of data files. Settings should be checked before first start. 

 

 

Figure 6.2: Menu tabs 

6.2.1 Main tab menu functions 

When Main tab is selected, drop down menu for function selection appear on the screen. Document 

handling and Report Creation functions are common with Home tab, other functions are specific and can be 

accessed from Main tab menu only. All functions, presented on Figure 6.3, are available only when Data 

structure file is opened. 

 
 

Figure 6.3: Main tab menu 

 

Main tab menu specific functions: 

• : Combines two Metrel ES Manager Data structure files into single file. From Merge 

files menu, user can select master file and target file. All data are merged, same items contained 

in target file are overridden with master file items. When merging a file with attachments (e.g. 

from aMESM) and a file without attachments (e.g. from instrument) make sure that the master 

file is the file with attachments. 

• :Support for importing data from previous generation of management software; 

Options: 

Import EUL: import Euro Link PRO data structure files (EUL files for instruments EurotestXE) 
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Import EUL structure only: import structure only from EUL files (instruments EurotestXA) 

Import from PAT Link PRO: import data files exported from PATLink PRO 

Import from aPAT: import data files exported from android application aPAT 

Import from Excel: opens Excel to Metrel ESM file converter. Metrel Cloud tool provides wizard 

to set parameters to convert Excel (.xls) data to Data structure (.padfx) file format. 

• : Support for exporting data to Excel or XML file format;  

Options: 

ToExcel Basic EIS export: exports power installations Structure and Test data to Excel table 

ToExcel Basic PAT export: exports Structure, Test data and Appliance data to Excel table 

ToXML Basic EIS export: exports power installations Structure and Test data to XML file 

ToXML Basic PAT export: exports Structure, Test data and Appliance data to XML file 

Pro Export: Licenced, user defined Test project Data structure export to Excel file format. 

Available, if tests was performed with Instrument with sufficient licence key rights. See chapter 

10.1.3 Pro Export to Excel file format for details. 

• : Opens menu for setting general and global data, language, managing licences 

and printout headers. See Chapter 6.2.1.1 Settings Menu for details. 

• : Opens Metrel ES Manager Help menu. PDF reader must be installed on PC for help 

file reading. 

• : Metrel ES Manager version information and Check for software updates option. 

• : Exits application. 

6.2.1.1 Settings Menu 

Settings Menu functions are organized in tab style, see Figure 6.4: Settings Tabs example. 

 

 
 

 
 

Figure 6.4: Settings Tabs example 
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General tab functions 
Set default folder for Metrel ES Manager Documents. Use browser to select existing or set new folder on 

PC, then confirm selection. 

Default document path is offered every time the document handling functions (Save, Save as, Open) are 

activated. It is also default search folder, when Upcoming retests Tool from home tab is activated. 

Options:  check box for automatic Report page numbering; uncheck if 

manual page numbering is required for Reports. 

Global Settings tab 
Global parameters setting. Presented parameters depends on Work scope setting.  

Review current settings, if necessary set new with selection from drop-down list; confirm new selection. 

Licences tab functions 
Instrument serial number and it licence key must be entered to activate functionalities of the ES 

Manager software adjusted to individual measuring instrument. The serial number of the instrument, 

the set of associated license keys and it Feature set are shown in the table, see Figure 6.5: Licenses tab 

menu. 

Options: 

 : Field for manual entry of instrument Serial Number 

 : Field for manual entry of associated License Key 

 : Add manual entry to the list 

: Opens browser to import Licence key from the file; navigate to the 

folder location on the PC, select Licence file (*.lic) and Open it. 

: Opens browser for exporting selected Licence key to the file; name the 

Licence file, navigate to the folder location on the PC and Save. 

: Synchronize License keys with connected instrument. 

 

Note: 

Basic licence key offers limited managing of professional Reports, they could be filled with downloaded 

data, but printing is disabled. 

PRO licence key offers full functionality of professional Reports associated with Licence key Feature set. 
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Figure 6.5: Licenses tab menu 

Language tab 

: Current language is marked with blue dot in selection field. Select user 

language from the list. New selection will take effect after Metrel ES Manager restart. 

Report settings tab functions 
User can define custom header logo, address fields content and data presentation printed on the Report 

document. Report setting is organized in tabs separately for: 

Print results : Logo image can be chosen and address Field 1 and Field 2 can be selected from database. 

Basic reports: two logos and measurement name presentation on report can be chosen. 

Pro Report Export: measurement data, client data and address, responsible person data, Report data 

presentation can be set. 

Cloud tab 
For communication with Metrel Cloud, User API key should be generated in Metrel Cloud and copied into 

the API key field. Cloud tab setting option is available only for specific Work scope setting. 

 

 
Option: 

 : Check to select Metrel Cloud as default save location. 

 

6.2.2 Home tab functions 

Home tab menu functions appearance depends on Work scope setting. Function groups provided are: 

• Document 

• Communication 

• Reports 

• Tools 

• PV database explorer 

• Setting 

 

 
 

 

Figure 6.6: Home tab menu examples 
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Document menu 

• : Navigates to welcome screen. 

• : Creates a new, empty ES Manager document/database. 

• : Opens an existing ES Manager document from default save location. 

Options (for specific Work scope setting only): 

Open from PC: appear when default save location is set to Cloud 

Open from Cloud: appear when default save location is PC 

• : Save the ES Manager document/database. 

Options: 

Save - Saves the currently focused ES Manager document file to the default save location. If the 

file has not been saved yet (data was downloaded from the instrument, or user created a new file), 

the user will be prompted to define a location and name for the file. 

Save as - File will be saved under different name. The user is prompted to define a new location and 

name for the file. 

Save to cloud: Saves the currently focused ES Manager document file to the Cloud (for specific 

Work scope setting only). 

 

Communication functions 

Communication menu contains commands related to downloading data from / uploading data to 

instruments. 

• : Gets data from instrument. 

• : Sends data to instrument. 

• : Basic information and Firmware update status (if PC is connected to the internet) 

of the instrument are presented on the screen. 

• : Opens menu window for managing transfer of group of data files between connected 

instrument and PC. 
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Reports functions 

Reports tools group from Home menu tab are available only when Data structure file is opened. 

• : Opens list of prescribed or standardized Report Forms. 

Options: 

Create Report: Creates Report based on selected Report form 

Create from Template: Creates Report based on Report template file (*.rtmpl); user is prompted to 

 

• : Opens list of existing reports for managing based on current selected data structure file. 

• : Opens window with list of Web Report templates from Cloud. User is prompted first to 

save ES Manager document file to the Cloud, if not already. Select template and Create report 

command to open Web Report Editor application. Function is available for specific Work scope 

setting only. 

 

Tools menu 

• : Opens browser to navigate to the Report template files folder location on the PC. 

Selected Report template file (*.rtmpl) is opened in Report editor. 

• : Opens menu window for managing Scheduled retests for appliance testing. 

Note: Document path should be set first (see Chapter 6.2.1.1 Settings Menu); Scheduled retest 

editor will automatically search for appliances within Data structure files saved in the set folder 

location. 

• : Opens Results report in Preview window, from which page layout could be edited 

before printing or exporting to pdf or image file. 

• : Opens compact form of Results report in Preview window, from which page 

layout could be edited before printing or exporting to pdf or image file. 

Option  

• : Tool for programming Auto Sequence® tests. Refer to individual Instruction 

Manual of instruments for more information. 

• : Opens Metrel Cloud location, if User is already signed in. If not, Sign-in window is opened. 

Cloud is available for specific Work scope setting only. 
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Setting menu 

• : Choose the scope for applying working area from available menu of Work scopes: LV 

and HV installations safety testing, portable appliance testing, production line safety testing, 

industrial machine testing, PV testing  Structure elements, Measurements, Tools and Reports are 

adjusted to the selected area. 

 

PV database explorer 

PV database explorer is available only when Work scope Photovoltaic Region / PV testing or Safety of LV 

Installations (old instruments) is selected from Setting menu. 

• : Opens PV database management window. 

Options: 

Public database: Comprehensive list of manufacturers and their PV module products with 

search function 

Private database: user configurable PV module database; User can select modules from Public 

database or manually enter Module 

List of Modules: user can create list of modules and save it to the file or open saved module list 

and save selected data to Private database location. List of Modules can be uploaded to the 

test instrument, see Chapter 8.2.2 Multiple file transfer options for details. 

Module Data: Form for presentation of selected PV module data or manual entry of PV module 

data and saving it to database. 
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6.2.3 Structure Tab functions 

Structure tab provides structure elements, Measurements and necessary editing commands to build 

custom tree-like structure of the test object. Function groups provided from Structure tab menu (Figure 

6.7) are: 

• Edit 

• Structure 

• Measurements 

• Filtering 

Elements of the tree structure can be equipped with planed measurements to be performed on test 

location. Structure elements available from Structure group, tests available from Measurements group and 

Filters from Filtering group depends on Work scope selection from Main tab / Setting menu. 

 

 
 

 

Figure 6.7: Structure tabs  Installations and PAT Work scope 

 

Edit menu group 

Basic editing command icons are provided in Edit menu group. By clicking on icon, command is executed 

on selected data structure element. By mouse right-clicking on data structure element, context sensitive 

menu appear on the screen, from which additional editing commands can be selected (Figure 6.8.) 

Depending on the node selected, different menu items which apply to that type of node will be 

displayed. 

• : Copies selected data structure element together with all subtree data structure 

elements and associated measurements to the clipboard. 

• : Paste data from the clipboard to the selected data structure element within existing 

or another data structure file. The results of measurement are not included. Measurements are 
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pasted as new empty measurements. Command is disabled if no data was copied or if the current 

selected element does not allow pasting.  

• : Paste data from the clipboard to the selected data structure element within another 

data structure file. When within same file, command is executed as Paste as new; duplicates of 

unique elements are not allowed within same file. Command is disabled if no data was copied or 

if the current selected element does not allow pasting. 

• : Deletes the currently selected data structure element together with all subtree data 

structure elements and associated measurements. 

• : Cut the currently selected Appliance within Results area together with associated 

measurements to the clipboard. Only active in the Appliance testing Work scopes. 

• : Paste cut items from the clipboard to the selected data structure element within 

existing or another data structure file. Command is disabled if no data was cat or if the currently 

selected element does not allow pasting. Only active in the Appliance testing Work scopes. 

 

 
 

Figure 6.8: Context sensitive edit commands 

 

Structure menu group 

Menu group Structure contains all structure elements for design of custom specific Data structure for 

on-site testing. Structure group elements type depends on Work scope setting (Figure 6.9). With click 

on element it is inserted into the structure tree. 

Structure elements are in hierarchical relationship. Parent element type (currently selected element 

within tree structure) define, which elements can be inserted as child elements, those elements are 

highlighted, and the rest of elements are dimmed. By positioning the mouse pointer to the element, its 

name and description are presented. 

 



User Interface Components 

 

25 

      
 

 

Figure 6.9: Structure elements  Work scope PAT, Production Line Testing and Installations  

 

Measurements menu group 

Measurements menu contains a selection of tools for attaching Single tests, Auto Sequence® tests and 

Inspections to the structure elements. Type of Measurements, appearing within each tool list, depends 

on Work scope setting. 

•  : Opens list of available single tests, select one by clicking on it name. It window 

appear on the screen, set parameters and limits and confirm. Single test is appended to the 

selected element within Structure tree. 

• : Opens list of available Auto Sequence® tests, if Auto Sequence® Group file 

(*.atmpx) was opened before. Double-click on Auto Sequence® test append it to the selected 

element within Structure tree. 

Option: 

Browse for the Auto Sequence Group file: Open browser to navigate to the Auto Sequence® 

Group file folder location; select one and confirm selection to open it. The new Auto Sequence® 

Group file will replace the existing one. This menu is available by clicking on the triangle inside 

the button. 

Note: Only one Auto Sequence® Group file can be opened at the same time. 

• : Opens a list of available Inspections, select one by clicking on its name. A new 

window appears on the screen. Confirm the selection. The inspection is appended to the 

selected element within the Structure tree. 

 

Filtering menu 

Only active in the Appliance testing Work scopes. 

• : Opens Custom filter design tab at the top of Result view area. See Chapter 6.3.3.1 

Results view area for Appliance testing Work scope for more details. 
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6.2.4 Database Tab 

Frequently used data can be written to the organized tables provided in the Database tab. This data can be 

appended to the Structure elements or to the Print results header (see Settings / Printout headers). 

Appearance of the Database tab menu (Figure 6.10) depends on the Work scope setting. Its main areas are: 

• Contacts 

• Structure names 

• Custom Lists 

 

 
 

Figure 6.10: Database tab  Client list in Contacts group is selected 

 

Contacts data lists 
Organized tables are provided for custom Contacts data entry (Organization, Name, Address, Telephone, 

eMail etc.), which could be appended to the structure elements with simple selection from the drop-down 

list. Common to all Work scope settings (and their utility purposes) are: 

• Client (element Client / PAT testing, element Location / Installations testing) 

• Addresses (element Location / Installations testing, Header of Print results) 

• Responsible person (element Location / Installations testing, Header of Print results) 

All PAT testing regions have an additional table:  

• Address of location (element Location / PAT testing) 

 

Edit menu options: 

• : Clear all data entry from selected Contacts list. 

• : Delete selected row from the Contacts list 

 

Structure Names data list 
The Structure Names list is a fixed list of Elements, which could be used to build custom tree-like structure 

of the test object (Figure 6.11). User can customize the name of the Element under which it is presented 

within tree structure. Listed elements depends on Work scope setting. 

Structure Names data columns are: 

• Picture: graphic presentation of the element 
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• Default name: Metrel ES Manager Default Element name 

• Custom name: User defined name of the element; select current Custom name and edit it. 

 

 

Figure 6.11: Structure Names 

Edit options: 

• : Structure Names list is set to default state. After the Warning confirmation, all Custom 

names are reset to default names. 

Note: 

A Custom name is always used to present Elements within a tree structure, when appended to the location. 

By default, the Custom name is the same as Default name of the element. 

 

Custom Lists 
Custom data lists (Figure 6.12) are provided for entry of frequently used data of test objects, which could be 

appended to the structure elements presenting electrical equipment, with simple selection from drop-down 

list: 

• Appliance ID user can enter custom appliance ID 

• Name: user defined name of electrical equipment 

• Group: user defined name of appliance group (appliance testing work scopes only)  

• Location (Room): user defined name of the space location 

 

 

Figure 6.12: Custom list Name 
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By default, Appliance ID and Location (Room) lists are empty, Name and Group are partially filled, all ready 

for custom entry. 

 

Edit menu options: 

• : Selected list is restored to default state, custom entries are deleted. 

• : Delete selected row from the list 

6.3 Metrel ES Manager User workspace 

User workspace is presented on the Figure 6.13 below. Multiple Data structure files can be opened at the 

same time, independent of their Work scope setting. Their names are listed within the Document tab-strip 

(). The currently active Data structure file tab is highlighted. 

The data structure file content is presented in three main areas within the user workspace, each providing 

special insight into the file data content, for easier navigation and data survey: 

• Tree View window () 

• Result view area (), 

• Properties window () 

 

Figure 6.13: User workspace  

6.3.1 User workspace management 

The result view area is always in the centre of the User workspace and acts as a container (parent) window to 

which the Tree View window and the Properties window are appended. When a data structure file is opened 

or downloaded from the instrument, the Tree View and the Properties windows appear on the left and on the 

right side. 

A user can manage the appearance of a workspace with: 

• Resize Tree view and Properties window width: position the mouse marker on the window edge, 

when the arrow ( ) appears, left click and drag it to the left or right. 
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• Resize Result view columns: position the mouse marker on the column on the left edge in the title 

bar, when arrow ( ) appear, apply left click and drag it to the left or right. 

6.3.2 Tree View options 

The tree view (Figure 6.14) allows you to navigate through the data structure and displays the status of 

the measurements performed on objects by adding measurement status symbols to object icons. 

Use buttons under the title bar () to navigate: 

• : Expands all nodes of the data structure. 

• : Collapses all nodes of the data structure 

• : Find panel () to search for the text string entered in the field. All string 

appearances are highlighted within the data structure tree. 

Use the triangle mark in front of the object to expand / collapse subtree nodes: 

• : Structure object subtree is collapsed, click triangle mark to expand node. 

• : Structure object subtree is expanded, click triangle mark to collapse node.  

Right click on the structure element opens the menu window () with commands: 

• Copy, Paste as new, Paste as same, Delete, Rename items are functions for manipulating data 

structure objects and measurements. 

• Add / Edit Comment: Write a short comment which appears as a string below a selected object 

(). 

• Add Attachment: Add attachment to the selected object. Notification ( ) appear in the 

attachment column of the data structure tree. An attachment can be any data type (a 

picture, a text file, an object, etc). It can be opened, edited, or removed. Click on a notification to 

present a list of object attachments. 

Note: 

Attachments are only stored in the current data structure file and will not be sent to the 

instrument. When a data structure file with attachments is sent to the instrument and then 

downloaded back into a new data structure file, the attachments in the new data structure file 

will be lost. You will have to merge the downloaded file with the original file. Additionally, you 

may have the original file opened in MESM. When downloading, MESM will ask you whether 

you wish to merge the files or download the file as a new one. 

• Print TreeView: opens the current Tree view (only selected nodes expanded) in a Preview manager 

window. The preview contains all standard functions for editing printable files, it is possible to edit 

the Header and the Footer, set the Background colour. Also, you can Export edited document in 

*.pdf format.  

• Print All Nodes: expands all nodes and opens the Tree view in the Preview manager window. 

• Instrument data: Data of the instrument with which measurements were performed. Available for 

finished measurements (single tests or Auto Sequence® tests) only. 
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Figure 6.14: Tree View 

 

Structure object test status indication 

Auto Sequence® tests and other structure objects. Test status is indicated with a dot following the icon: 

• : Empty status (not yet performed) measurement is associated with the object; click on 

the triangle in front to expand the branch and view the contents of the measurement. 

• : Performed measurement with Fail status is associated with the object; click on the 

triangle in front to expand the node and view individual test  statuses. 

• : Performed measurement with Pass status has no special indication; click on the triangle 

in front to expand the node and view individual test  statuses. 

• : An object without a triangle mark in front has no measurements associated. 

• : At least one measurement within the object subtree has a Fail status. 

• There are measurements with Empty statuses and measurements with Fail statuses 

within the object subtree. 

 

Single test measurement status indication 

Measurement status is indicated with a circle in front of a Single test name. 

• : A finished measurement with a passed test result performed by the instrument. 

• : A finished measurement with a failed test result performed by the instrument. 

• : A finished measurement with test results and no status performed by the instrument. 

• : Empty measurement without any test results. 

• : Virtual  A passed measurement with manually added test results on PC SW. 

• : Virtual  A failed measurement with manually added test results on PC SW. 
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• : Virtual  A finished measurement with manually added test results and no status on PC SW. 

6.3.3 Results view area options 

The Results view area is intended for a detailed survey of measurements associated with data structure 

elements. The Result view area appearance and options depend on the Work scope setting. See chapter 

6.3.3.1 Results view area for Appliance testing Work scope for additional options. 

 

Display of measurement data (Figure 6.15: Results view area) is organized in table manner, including: 

• Function path - object directory within a Tree structure and appended measurement names (). A 

left mouse click on the triangle at the beginning of the row expands ( ) or collapses ( ) the 

measurement data. 

• Measurement data with Test name, Results, Sub-results, Parameters and Limits setting (). 

• Test status column (). 

• Measurement test Date and Time (). 

The result view area is focused on the selected object within the Tree View; measurement results associated 

with the subtree structure of the selected object are presented. 

 

Measurement data Filter: presentation can be filtered with a selection from a drop-down menu in the upper right 

corner: 

• : Results, Sub-results, Parameters and Limits setting are presented. 

• : only Results and Sub-results are presented. 

 

Measurement status is written in the status column: 

• Pass: finished measurements with passed test results. 

• Fail: finished measurements with failed test results. 

• Nothing: Finished measurements with test results and no statuses. 

• Empty: Empty measurements without test results. 
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Figure 6.15: Results view area 

 

Commands available with a right click on the data row are: 

• Edit: edit test parameters and limits of empty measurements. 

• Print selected: print Results of the selected Structure Object. 

• Print all: print Results off all Structure Objects. 

• Expand all: Expands all Function paths to see measurements data. 

• Collapse all: Collapse measurements data to see Function paths only. 

• Show graphs: Opens window for a graphic presentation of measurements results. Available for 

measurements which contain graphs. 

Note: 

Measurements with parameter sweep mode setting within the Safety of HV installations Protective Earthing Work 

scope. 

6.3.3.1 Results view area for Appliance testing Work scope 

When Work scope is set to Appliance safety testing, the Appliances table with extended information 

organized in additional table columns appear within the Result view area (Figure 6.16): 

• Appliance ID: identification of the tested appliance. 

• Structure path: Appliance directory within the Data Structure tree. 

• Name: Appliance name. 

• Next test: Date of next test for the Appliance with set Test period. 

• Test date: Test Date from the instrument. 

• Status: Test status 

 

The Appliances table is focused on a selected object within the Tree View; measurement results associated 

with the appliances located within the subtree structure of a selected object are listed in the table. 
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Interactively, when a left click is applied on the Appliances table row within the Result view area, an 

adequate Tree view branch is expanded, and the selected item is highlighted. 

 

 
 

Figure 6.16: Appliance safety testing Results view area appearance 

 

Sort order filter 

 

• : Click to the column name field to activate sort filter. 

Each Appliances table column provides a sort filter. An active sort column is marked with an arrow on the 

left side of the column name field. Click again to reverse the sort order. The sort filter can only be active in 

one column at the same time. 

 

 

Appliance table column filter 

• : Position mouse over column name field and click filter sign appearing on the 

right-up corner of the cell to activate column filter. 

Each column of the Appliance table contains a filter. After filter is selected, menu with filter options appears 

on the screen. Select the option and close the window to activate the filter. Active column filter remains 

marked with the blue filter sign within name field, see Figure 6.17 below. 

 

 

Figure 6.17: Results view area column filters  Name and Status are active. 

 

More column filters can be active at the same time. 

To remove column filter, select it and choose the Clear Filter command from filter settings menu. 
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Appliances table Custom Data filter 

Custom Data filter can be active within any column of the Appliances table, one or more filters can be active 

at the same time.  

• : Right click within Results view area to open a menu window and check Custom filter 

option to open Custom filter design tab at the top of Result view area (), see Figure 6.18. 

• Position mouse over any field within filter tab and click to open additional filter criteria or change 

or delete it. 

• Options available for manage designed Custom Data filter are: 

Apply filter: Filter is applied to the Appliance data table, active data filters are marked within 

data column name field. 

Save filter: Menu is opened to Name and save filter in Filters folder of MESM application. 

Load filter: Load filter from Filters folder of MESM application. 

Save filter as: Menu is opened to Rename and save filter. 

New filter: Opens new filter tab with logic function relationship field by default. 

• : Custom filter design is offered as a row beneath Address row of the Appliance table 

(), see Figure 6.18. Custom filter and Row filter are equivalent. Settings of the Custom filter 

are mirrored to the Row filter and vice versa. 

 

 

Figure 6.18: Appliance Custom Data filter design options 

 

Appliances table Find filter 

A right click within the Appliances table offers a menu window, from which a Find panel can be selected: 

•  A Field for Find filter is opened at the top of the Result view area (). 

• () Enter the string to be found within the Appliances table; search starts automatically. 

• () Found string appearances are highlighted and the Appliances table is filtered to the rows 

containing the found string. 

•    Remove the find filter and clear the entry field. 

 

 

Figure 6.19: Appliance data Find filter design options 
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Appliances table commands 

A right click within the Appliances table offers a menu window, from which the following commands can be 

selected: 

• : Clear all filters from the Appliances table. 

• : Delete the selected item. 

• : Delete all items from the appliances table. 

6.3.4 Properties window options 

The Properties window presents a description of the objects allocated within the Project Data Structure tree. 

The Properties window appearance depends on the Work scope setting and assigned properties to the object 

type. 

Current Properties window view (Figure 6.20) is focused on the object selected in the Tree view: 

• Selected object properties and properties of all parent objects within the data structure are presented 

in separate tabs within a Properties tab strip (). By default, the selected object tab is active. Click 

on the parent object tab to see its properties. Use arrows at the end of the tab strip to scroll between 

the tabs. 

• A list of assigned properties to the object is presented on the left side (). Click on the entry field on 

the right side and write the property value. 

• When a list of predefined properties is available, arrow appear at the end of entry field (). Click on 

the arrow to open a drop-down menu and select a property value. 

• When work scope is set to PAT or Machine, switchgear and PAT testing, Risk Analysis statistics is 

promptly evaluated and presented within Properties window (). Error rate is ratio between FAIL and 

PASS number of tests. Current result can be printed or exported to *.pdf file; click on Print button to 

open page editor window. 

 

 

Figure 6.20: Properties window 
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7 Creating Data Structures 

7.1 Considerations regarding new test project Data Structure 

Metrel ES Manager supports creating a tree-like Data Structure of Test projects, with Objects under test 

located within the tree nodes in hierarchical relationship. Measurements can be appended to the Objects 

before uploading a Data structure file to the instrument. 

 

Before opening a new Data Structure file of a Test project, consider on: 

• Work Scope: Determine the Work scope of the Test project. 

• Data structure tree: Determine the Data structure of the Test project - Test Objects and their 

hierarchical relationships within the tree-like project presentation. 

• Data lists with Properties: Consider the Test Objects  properties to be described for consistent 

results  presentation and Test report creation. 

• Auto Sequence® tests: For faster test execution, collect specified tests for each individual object and 

create an Auto Sequence® Group of tests. A Auto Sequence® test can contain custom created 

Inspection tests. Refer to individual Instrument Instruction manual for details. 

7.1.1 Work scope Safety of LV Old_instruments considerations 

The Metrel ES Manager supports managing of Test project data of the previous generation Installations 

testers, when Work scope Safety of LV Old_instruments is selected. Due to the limitations of those 

Instruments, the following should be considered, when creating Data structures to be uploaded as Test 

projects or downloading data from the Instrument: 

• The data structure should have only one Node. Only objects under the first node of the Data structure 

are uploaded, objects under other Nodes are omitted. 

• The data structure tree can have, beside the object Node, three hierarchical levels only. Object Node 

is omitted when the Data structure is uploaded to the Instrument. 

• Measurements attached to the Data structure elements are not uploaded. 

• Retest is not supported; when Data structure with finished measurements is uploaded for test 

repetition, only structure elements are uploaded, measurements are omitted. 

• Only one Data structure file can be uploaded at the same time. Command Connect, intended for 

multiple file transfer, is not supported in previous generation testers. Uploading of new Data 

structure files deletes the existing Instrument memory content. 

• Command option Download to New file should be chosen, when downloading Instrument memory 

data. If the option Download to Current opened File is chosen, the downloaded data appears under a 

new node, created within the existing opened file, data under the original node is deleted. The data 

contained in the already opened file could be lost. 

• Creation of Group of Auto Sequence® tests is not supported. 

7.2 Open new test project Data Structure 

To open a new test project Data Structure file, follow the procedure: 

• Optionally, set a Document path from the Main tab / Settings / General tab menu. 

• Select the Home tab of the User workspace. 

• Select Settings / Work scope from Home menu tab. 
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• Choose a New file from Home user workspace or Home tab (or Main tab). 

New Data structure file *.padfx is opened with default file name New Document*. The User Workspace area 

is empty, except a parent object Node is automatically placed to the Tree view. This is the starting point to 

creating a project Data Structure. It cannot be deleted, because at least one Node must exist within a 

structure tree. It can be renamed to reflect the subject of the Test project. 

 

Before starting to create a Data structure, it is recommended to: 

• Rename the file using the Save as command from the Home tab menu, to reflect the subject of the 

Test project. 

• Open an adequate Auto Sequence® Group file (if available) containing the required tests for the 

project. Only one Auto Sequence® group file can be opened at the same time. 

7.2.1 Creating a new Data structure 

Creation of a new Data structure starts from a Tree view of a User workspace, Figure 7.1 : 

• Select the Structure tab menu (). Available Objects are highlighted within the Structure group 

menu. 

• The default object Node is already selected within the Tree view. Click on the structure element within 

the Structure menu group to insert it to the structure tree. It appears as a structure element (), 

hierarchically is a child structure element under parent Node. To place another structure element, 

repeat the action. 

• To expand the node, select an Object within the Tree view and click on the new Object within the 

Structure menu group. It appears as a child object under the selected one. To further expand the node, 

select the child object and repeat the action. 

• To create a node subtree, select the node Object and repeat placing new objects as child items on the 

same level (). Child items are new nodes of the Object subtree. 

• Describe the Objects in the Properties window of the User workspace (). When a Name property is 

entered, the default Object name within the Tree view is automatically updated. 

Each Object type has a dedicated set of properties, which can be manually entered or selected from 

the embedded or user created Database lists. Describe all the necessary properties to provide a 

detailed overview of the test results and well-defined Test Reports. 

• Repeat the actions above until the determined test project Data structure is finished. Save the file. 
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Figure 7.1: Creating new Data structure 

7.2.2 Appending measurements to the Data structure Objects 

Accurate and reliable test results are insured, when required measurements are parameterized and appended 

to the test objects before uploading the test project Data structure to the instrument. The operator can start 

the tests from the instrument  Memory organizer and save the results under the same Object. 

Procedure: 

Select the Object and append empty measurements. From the Measurements group of the Structure tab 

menu, the user can select: 

• : Clicking on the icon opens a list of available Single tests, organized in groups. 

o Expand single test groups and select a single test from the list by clicking on its name. 

o Single test settings window appears on the screen, with default parameters and limits 

value set. 

o Set parameters and limits according to the Test project requirements for the selected 

object. 

o Click OK to confirm the settings- The single test is appended to the selected Object. 

o Parameters and limits can be reviewed and set again later. Clicking on the Single test name 

within the Tree view presents its contents in the Result view. Double clicking on its name 

in the Result view opens the Single test settings window () in Figure 7.2. 

o Reset parameters and limits and confirm new settings by clicking on the OK button. 

• : Optional command:  

Clicking on the icon opens a list of available Auto Sequence® tests from the opened Auto 

Sequence® Group. 

o Expand the file folders to find the requested Auto Sequence® test. 

o Double-clicking on the Auto Sequence® test automatically appends it to the selected object. 

o If necessary, parameters and limits of the Auto Sequence® test can be reviewed and set later, 

Figure 7.2. Expand the Auto Sequence® test node in the Tree view () to see its single test 

contents. 

o Select a Single test in the Tree view () to present its content in the Result view area. 

o Double clicking on a Single test name in the Result view () open its settings window (). 

o Reset the parameters and limits and confirm new setting by click on the OK button. 

o Note: The Auto Sequence® test with changed parameters and limits setting is not marked. To 

distinguish it from the original, the user can add a comment to its Name in the Tree view. 
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Figure 7.2: Edit Auto Sequence® test parameters and limits 

 

• : Optional command: Browse for Group of Autotests file:  

Clicking on the triangle offers a command to open a browser to navigate to the Auto Sequence® 

Group file folder location containing the requested Auto sequence® test; select the file and confirm 

the selection to open it. The new Auto Sequence® Group file will replace the existing one. Only one 

Auto Sequence® Group file can be opened at any time. 

 

•  : Clicking on the icon opens a list of available standardized Inspections, organized in groups. 

o Expand the Inspection group and select the Inspection from the list by clicking on its name. 

o The inspection window appears on the screen, with default Empty status of inspection items. 

o At the top of the tab you can add meta-data (date and time) to configurable inspections. 

o Click OK to confirm the inspection. It is appended to the selected Object. 

7.3 Creating Data structures using Copy and Paste commands 

If a part of a Data structure is repeated often, it is possible to create large structures with measurements in a 

fast and simple way simply with the help of Copy and Paste commands. 

Objects from one Data structure can be copied to another test project Data structure file if the Work scope 

settings of both files are the same. Data structures can be new, without measurements, with appended 

empty measurements or downloaded from instruments with executed measurements. 

 

Note the item identification rule, influencing paste commands behaviour: 

Each Object and measurement inserted to the data structure gets an internal unique identification number. 

Only one item with the same unique identification number can exist within the same Data structure. 
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Commands are available from the menu window, appearing on the screen after right-clicking on the Object 

within the Tree view or from the Structure tab Edit menu: 

• Copy command:  

o Selected an Object and all Objects located under the selected Object subtree structure are 

copied. 

o Measurements appended to the Objects, empty or executed, are also copied. 

o Properties of each copied Object are also copied. 

• Paste as new: 

o Copied Object and all Objects located within its subtree are pasted to the new selected 

location. 

o Empty measurements appended to the objects are also pasted and remain unchanged. 

o Executed measurements are pasted as empty measurements! 

o All pasted Objects and Measurements get a new internal unique identification numbers! 

o Properties of each Object are pasted and remain unchanged! 

• Paste as same: 

o Copied Object and all Objects located within its subtree are pasted to the new selected 

location. 

o Measurements appended to the Objects, empty or executed remain unchanged. 

o All pasted Objects and Measurements retain the same internal unique identification 

number! 

o Properties of each Object are pasted and remain unchanged! 

Note: 

When Paste commands are greyed out, pasting data to the selected location is not allowed due to hierarchical 

relationship between the copied object and the paste object or no data was copied before. 

 

7.3.1 Copying and Pasting within the same Data structure file 

Copy&Paste as new: a structure Object with sub-tree Objects with empty 

measurements or without them: 
This command sequence is useful to expand Data structures with often repeated common nodes, e.g. a Hotel 

with multiple floors, each containing equally equipped rooms (Figure 7.3): 

• Select an Object presenting node () (First floor) and execute the Copy command 

• Select a new location Object () (Hotel) and execute the Paste as new command; repeat for each 

new node 

o Paste as new was repeated twice (), presenting two new nodes  hotel floors. 

o All objects within the pasted nodes have new unique identifications, but its names, 

Properties and appended measurements remains the same. 

• Select each new object within the new nodes and update only their Properties (), which 

distinguish them from the copied node objects. 
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Figure 7.3: Copy&Paste as new operation within same Data structure - empty measurements appended 

 

Copy&Paste as new: a structure Object with sub-tree Objects with finished 

measurements: 
This commands sequence is useful when creating new Data structures with same Objects and their 

Properties and same empty measurements appended as source Data structure with finished 

measurements, to perform the same test project again on same or another equal location (Figure 7.4): 

• Select the most presented parent Object in a data structure with finished measurements () and 

execute the Copy command. 

• Select a new location (new Node was inserted for demo) () and execute the Paste as new 

command: 

o Pasted Data structure tree and Object properties remain the same, all objects have new 

internal unique identifications to distinguish them from source Objects. 

o All appended measurements are empty (), without results, parameters and limits 

settings remains the same as they were set in finished measurements.  

All measurements have new internal unique identification. 
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Figure 7.4: Copy&Paste as new operation within same Data structure - finished measurements with results 

 

 

Copy&Paste as same: 
Internal unique identification rule prevents the Paste as same command to execute within the same Data 

structure file. Paste as same command is executed as Paste as new, Information message (Figure 7.5) 

appear on the screen for a short time. 

 

 
 

Figure 7.5: Copy&Paste as same within same Data structure  information message 
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7.3.2 Copy and Paste between different Data structure files 

A source Data structure file and a target Data structure file should be opened at the same time. The same 

Work scope must be set for both the Source and the Target Data structure. 

 

Copy&Paste command sequence execution always begin with the same procedure: 

• Select a Source Data structure file tab to become active within the User workspace. 

• Select the used most parent Object within the Tree View, which subtree structure should be copied 

and execute the Copy command. 

 

Paste as new: 

• Select a Target Data structure file tab to become active within the User workspace. 

• Select a parent Object in the Tree view within the Target Data structure and execute the Paste as 

new command 

o The pasted Data structure tree and Objects properties remain the same as at the Source, all 

objects have new internal unique identification numbers to distinguish them from the 

Source Objects. 

o All appended measurements, empty or with results from the Source file, are empty, without 

results, parameters and limits settings remain the same as they were set in the Source file.  

All measurements have new internal unique identification numbers. 

Execution of the Copy and Paste as new command sequence between different Data structure files has 

similar behaviour and usefulness as its execution within the same Data structure file, except that the Source 

data is not present in Target Data structure file. For use cases refer to chapter 7.3.1 Copying and Pasting 

within the same Data structure file. 

 

Paste as same: 
response depends on the Measurements  status, which are appended to the Source Data 

structure and on the internal Objects and measurements unique identification number within the Target Data 

structure. 

Paste as same: The Source Data Structure Objects with appended Empty Measurements (or without): 
• Select a Target Data structure file tab to become active within User workspace. 

• Select a parent Object in the Tree view within Target Data structure and execute the Paste as 

same command 

o Search for the internal unique Object and Measurements identification number within the 

Target Data structure and comparison with the Source Data structure automatically starts. 

• Equal unique identifications ware found: a merge confirmation information window Figure 7.6 

appears on the screen: 

o click OK to complete the Paste command with data merging after confirmation in the next 

step. 

Objects and Measurements keep the internal unique identification number. 

o click Cancel to stop the command  execution. The data will not be pasted. 

 

Figure 7.6: Merge confirmation information window 
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• No equal unique identifications: procedure continue with confirmation window, Figure 7.7 

o click Yes to complete the Paste command. Objects and Measurements keep the internal 

unique identification number. 

o click No to stop command  execution. The data will not be pasted. 

 

Figure 7.7: Paste as same confirmation information window 

 

Paste as same: Source Data structure Objects with appended Finished Measurements, Target Data 

structure has empty measurements or finished measurements executed with different instruments: 
• No equal Object unique identifications within the Source and target Data structures: 

o procedure is the same as described above. 

• Equal Object unique identifications within the Source and target Data structures: 

o procedure starts the way same as described above until the Merge confirmation step. 

Paste as same: Source Data structure Objects only, Target Data structure has empty measurements, 

finished measurements executed with different instruments or only a structure elements without any 

measurements. 

• User is prompted to select the next Paste command step, Figure 7.8: 

o Merge duplicates using source data: Target Data structure Objects with equal identification 

are updated with the source data, the rest of them are pasted as same as the source data. 

o Relocate structure: the source data will be pasted to Target Data structure as an additional 

node subtree. New objects have new internal unique identification numbers. 

• Conclude the paste command with a response to the Information message on the screen, already 

described above. 

 

Figure 7.8: Paste as same option confirmation window 

 

Merge: Case study example of the functionality: 
Hotel with multiple rooms and floors  A test report for the hotel is needed. 

A complete structure with measurements of the hotel is uploaded on multiple instruments. Each 

tester measures one floor only. Data from all instruments are downloaded to the Metrel ES Manager. 

The test report, if created now from individual Data structure file, will include complete structure 

but only with measurements for a single floor, which is not what is needed.  
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Using the Merge function, all downloaded Data structure files from different instruments can be 

merged into a single Data structure file containing the complete structure and the complete 

measurements. A complete Test project Report can now be created. 

 

Relocate: Case study example of functionality: 
Hotel with multiple rooms in multiple equal floors  A test report for the hotel is needed. 

The same Data structure, covering only a single hotel floor and measurements is uploaded on 

multiple instruments. Each tester measures one floor only. Data from all instruments are 

downloaded to the Metrel ES Manager. 

The test report, if created now from individual Data structure file, will include only single floor 

measurements, which is not what is needed. 

Using the Relocate function, data from all floors can be combined into a single document file. 

Complete test report can now be created. 

 

Merge functionality note: 
Source Data structure Objects with appended Empty Measurements, Target Data structure 

Objects with appended Finished measurements: 

o Merged Data structure and Objects remains the same, Empty Measurements are 

appended to an adequate Structure Objects in addition to the unchanged Finished 

Measurements. 

7.3.3 Copy and Paste between different Work scopes 

Data structures created in different Work scopes can be opened in User workspace at the same time. In 

general, content of Data structure cannot be copied to a Data structure created in another Work scope. 

However, there are exceptions for some structure objects, that are common within different Work 

scopes. 

For example, structure objects such as Appliance, Appliance FD, Machine with sub objects, EVSE with 

sub objects are common within different Work scopes and can be copied and pasted between Data 

structures created in different work scopes. 

Whenever Structure objects can be transferred between the Data structures of different Work scopes, 

this automatically means that all measurements can be transferred between the same Data structures 

too. 

Sharing data between Data structures with different Work scope is subjected to changes as the Work 

scopes are permanently improved. 

7.4 Creating Appliance periodic retest Data structure 

When tested Appliances have the Property Retest period set, and the Data structure files with finished 

measurements already exist, the Upcoming retests tool can be used to create a Retest project Data 

structure file. 

• Set the Document path (see Chapter 6.2.1.1 Settings Menu), where the Data structure files are 

saved. 

• Set the PAT safety testing Work scope from the Home tab Settings menu, Upcoming retest editor 

icon appears within the Home tab Tools group menu. 

• : Clicking on the icon opens a Scheduled retests editor menu window for editing 

Scheduled retests for appliance testing. 
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o Scheduled retest editor will automatically search for appliances within all Data structure files 

saved in the set folder location. 

• Scheduled retests editor Options (Figure 7.9): 

o Filter retest dates: Display the elements which need to be re-tested, depending on the filter 

settings. 

o Reload: Reload Scheduled retest appliance list. 

o Create a *.padfx file: Create a new Data structure of elements which need to be re-tested. 

Use shift+click, ctrl+click, click&drag within the selection column on the left for multiple 

appliances selection. When selected appliances belong to more than one Data structure file 

only one new Data structure file with multiple nodes is created. 

o Open selected file: Opens a Data structure file associated with the selected appliances. 

Multiple Data structure files may be opened if the selected appliances belong to more than 

one Data structure file. 

o Close: Close the Scheduled retests editor. 

o Print preview: Opens the Scheduled retests list in Preview window, from which page layout 

could be edited before printing or exporting to a PDF or image file. 

o Print: Direct printing of Scheduled retests list. 

o to PDF: Create Scheduled retests list in PDF format; the user is prompted to select a folder 

and a file name. 

 

 

Figure 7.9: Scheduled retests editor menu 

 

• From the scheduled retest appliance list select the Appliances to be retested and execute the 

Create .padfx file: 

o The retest Data structure file is opened in a new User workspace tab () with the given 

default name New Document. 

o Appliances are presented in the same Tree view Data structure (), with same Objects  

Properties () as they were in the source Data structure. Beside the previous Finished 

Measurement same Empty Measurement are appended (). 

o In the Result view area, previous Finished Measurement results can be reviewed, and new 

Empty Measurement parameters and limits can be edited (). 

• Use the Save As command option to give a name to the new Retest project with a Data structure 

file. 
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• The scheduler retest window automatically updates the list of appliances when measurements are 

performed on the instrument and downloaded back to the Metrel ES Manager. 

 

 

Figure 7.10: New Retest Data structure file 
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8 Communication with Instruments 

8.1 Establishing communication with instruments 

Communication with instruments is established via Serial port (RS-232 or USB) or Ethernet port. 

• Click on   ,  or  opens a dialog box for setting parameters of 

communication, see Figure 8.1: Setting communication. 

• From the drop-down list select a COM port, to which the instrument serial data port is connected. 

o Default serial data Baud rate is set to Auto, switch to Advanced tab to change it, if necessary. 

• Enter Hostname or IP Address and Port number for Ethernet connection. 

 

 

Figure 8.1: Setting communication 

 

8.1.1 Instrument info 

Basic information of the instrument (Name, Manufacturer, Type of instrument, Serial number, HW version, 

FW version, Calibration date, etc.) and Firmware update status can be obtained. If no data is displayed, see 

chapter Troubleshooting. 

Options: 

• Check for new updates: Check if new FW version exists. 

o Download: Download new instrument FW version 

• View release notes: Open release notes related to instrument type. 
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Figure 8.2: Instrument info screen options 

8.1.2 Upgrading the Firmware 

With new type of instruments there is a possibility within Metrel ES Manager to upgrade the firmware of 

your instrument with the latest version. An internet connection is needed. On the Instrument info screen 

click on the Download and follow the instructions link. A program (FlashMe) starts, which guides you 

through the upgrade procedure. For more information how this feature is supported for your instrument see 

the instrument  Instruction manual or contact your dealer. 

 

                         

8.2 Upload or download data files 

Upload or download of Data structure project files can be selected from Communication group of the Home 

tab menu. Single file and multiple file transfer are supported. 

8.2.1 Single file transfer options 

• : Downloads data from the instrument. Currently active Data structure file in the 

instrument  Memory Organizer is downloaded. 

o If only the Home tab of User workspace is active, the downloaded file is opened in a new User 

workspace tab. 

o If a Data structure file is already opened within the User workspace, a Download options 

selection box is opened, Figure 8.3: 

Download to New file: new Data structure tab is opened in the User workspace 

Download to Current opened File: Objects data with equal unique identification are merged, 

the rest of them appear as new within the active Data structure file. 

 

Note 
For detailed set up procedure please see the user manual of the attached 

instrument on your computer! User manuals can be downloaded from our 

Download centre [http://www.metrel.si /download-center.html]. 

http://www.metrel.si/download-center.html
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Figure 8.3: Download options selection box 

• : Uploads Active Data structure file to the instrument. 

8.2.2 Multiple file transfer options 

: Opens a file transfer menu window (Figure 8.4) for managing transfer of multiple files between 

the connected instrument and PC.  

 

 

Figure 8.4: File transfer menu window  

 

File transfer menu options: 

•  Communication setting  

o  Select Serial data port or Ethernet connection with instrument 

o  Type Host name or IP address to the entry field 

o     Type Ethernet port number to the entry field 

o   Select PC serial data port from the entry field list to which is connected instrument. 

o  Reload the data 
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• File transfer menu window contains dedicated tabs: 

o Transfer tab: Menu for multiple Data structure file transfer 

o Transfer Autotests tab: Auto Sequence® file transfer (available from Auto Sequence® Editor) 

o Transfer PV modules tab: Custom PV module files transfer menu (available if Work scope 

setting support it) 

o Licenses tab: List of Instrument licences 

o Instrument info tab: List of Instrument data 

• File transfer tab options are: 

o  PC file folder selection tool. Use arrows to navigate within structure and open folder 

content. 

o  List of files within the selected folder. Check the square in front of the file name to select 

the files to be uploaded to the instrument. 

o  List of files in the Instrument  memory. Check the square in front of the file name to select 

files to be downloaded to the PC folder. 

• File transfer tab Command options: 

o  Upload selected items to the instrument. 

o  Download selected items to the PC folder. 

o  Delete selected items from the instrument. 

 

Transfer PV modules menu options: 

• Transfer PV modules tab (Figure 8.5): 

o  PC file folder selection tool. Use arrows to navigate to the Custom PV module files folder. 

o  List of Custom PV module files within the selected folder. Check the square in front of the 

file name to select the files to be uploaded to the instrument. 

o  List of Instrument modules. Check the square in front of the module name to be uploaded 

or downloaded to the instrument. 

 

 

Figure 8.5: Transfer PV modules menu window  
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• Transfer PV modules tab commands 

o  Opens PV database management window. 

o  Move selected PV module from PV module file to Instrument modules list. 

o  Save selected PV modules from Instrument modules list to Custom PV module file. 

Browser is opened to navigate to the PC folder location. 

o  Navigate through List of PV Module files. 

o  Delete selected PV modules from the Instrument modules list. 

o  Download PV modules from the instrument to Instrument modules list. 

o  Upload selected PV modules from Instrument modules list to the instrument. 
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9 Printing results 

9.1 Printing results options 

Metrel ES Manager provides two simple print formats for Test project Results printout, available from the 

Tools group of the Home tab menu: 

• Print results, 

• Basic report with the Filtered basic report option. 

 

Before starting to create Test project Results, consider preparing: 

• A data base Addresses list  frequently used Customer data printed in the Results header. 

• A data base of Responsible persons list  frequently used Operator data printed in the Results 

header. 

• Logos to be printed within Results header 

9.1.1 Print results format 

Create Header of Test project Results document first: 

• Select Report settings tab of Settings menu from the Main tab menu list. 

• Select Printout results tab (Figure 9.1) to open Header setup options: 

o Change logo image: Opens a browser to navigate to the logos image folder. Select a logo and 

Open it. 

o Clear logo image: Delete the existing logo. 

o Field 1: Manually type Customer data or select it from a drop down list. A list of addresses 

from the MESM internal database is offered. 

o Field 2: Manually type the Responsible person name or select it from a drop-down list. A list 

of responsible persons from the MESM internal database is offered. 

 

 

Figure 9.1: Print results Header setup 
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• Open a test project Data structure file and within the Tree view select a node, for which data 

should be generated. Select Node to print all results, select Measurement to print results of only 

one test. 

• Clicking on  within the Tools group of the Home menu tab opens Test project 

Results document in Preview manager window, Figure 9.2 and Figure 9.3. 

 

 

Figure 9.2 

 
 

 
 

Figure 9.3: Print Results document format preview 

 

• Header of Test project Results document appears at the top of the first page: 

o Test site, Operator data and Logo () are as set in Printout results tab of the Settings menu. 

• Instrument data () was set automatically when the Data structure file was downloaded. 

• Footer of Test project Results document () appears at the bottom of each page and contains: 

o Signature field  entry by hand. 

o Created date is set automatically. 

o Page numbering is set automatically. 
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• Measurement Results with Parameters and Limits are presented in table (), equipped with 

individual test result status, each table starts with a Measurement path within a Data structure 

tree and overall status indication. 

• Edit Results document page layout and print it using the Preview manager commands. 

NOTE: 

Preview manager, besides the page editing and navigation commands, provides an Export group with 

options: 

• Export to PDF file:  Creates a report and opens the explorer browser window to save the document 

locally in a PDF file format. 

• Export to Image file: Creates a report and opens the explorer browser window to save the 

document locally in an image file format (selectable from a menu). 

• E-Mail as PDF file: Creates a file in PDF format and attaches it to an E-Mail message. 

• E-Mail as Image file: Creates an image file and attaches it to an E-Mail message. 

9.1.2 Basic report format 

Options available from the Tools group of the Home menu tab are: 

•  Click on icon: Basic report. 

•  Click on arrow: Filtered Basic report. 

Reports could be printed with a complete data structure or with selected data structure objects only. 

9.1.2.1 Creating Basic report 

Select Logo images to be printed in the Basic report document Header first: 

• Select Report settings tab of Settings menu from the Main tab menu list. 

• Select the Basic report tab (Figure 9.4) to open Logo setup options: 

o Browse: Opens a browser to navigate to the logos image folder; selects a logo and opens it. 

o Clear logo image: Deletes an existing logo. 

o Logo 1: Upper logo on the right side of the header. 

o Logo 2: Bottom logo on the right side of the header. 

o Number of printed characters: Specify the number of printed measurement name characters 

on the report. If set to -1 all measurement name characters are printed. 

 

 

Figure 9.4: Basic report header logo setup 
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• Open test project Data structure, select Node to print all results, select Measurement to print 

results of only one test. 

• Clicking on  within the Tools group of the Home menu tab opens the Test 

project  Basic report document in Preview manager window, Figure 9.5. 

•  Editing fields: Header and Footer of the Test project Basic report document has user editable 

fields, click on an icon in the Navigation command group of the Preview manager to highlight 

them. 

• Header of Test project Basic report document () appear on the top of each page: 

o Logo 1 and Logo 2 are as set in the Basic report tab of the Settings menu. 

o Editable fields (highlighted pastel blue) should be entered manually. 

• Complete Instrument data () appears at the beginning of the Results list on the first page only. 

The instrument data parameters are set automatically when Data structure file is downloaded. 

• Footer of the Test project Basic report document () appears at the bottom of each page and 

contains: 

o Signature field  entry by hand. 

o Page numbering is set automatically. 

o Editable fields (highlighted pastel blue) should be entered manually, including Date field. 

• Results () are presented in two table rows: 

o The first row begins with the Object icon, followed by the Object location path within the 

Data structure and instrument  serial number. 

o The second row begins with Measurement description, test date and overall status 

Results, parameters, limits of each individual test are presented one by one in a string. 

• Edit the Results document page layout and print it using the Preview manager commands. 

 

 

 
 

Figure 9.5: Basic report document format preview 
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NOTE: 

The Preview manager, besides the page editing and navigation commands, provides an Export group with 

options: 

• Export to PDF file: Creates a report and opens the explorer browser window to save the document 

locally in a PDF file format. 

• Export to Image file: Creates a report and opens the explorer browser window to save the 

document locally in an image file format (selectable from a menu). 

• E-Mail as PDF file: Creates a file in PDF format and attaches it to an E-Mail message. 

• E-Mail as Image file: Creates an image file and attaches it to an E-Mail message. 

9.1.2.2 Creating Filtered Basic report 

The procedure of creating Filtered Basic reports is the same as creating a Basic report, except that Filter 

options (Figure 9.6) can be set. A filter settings window appears on the screen after Filtered Basic report 

command is selected: 

• Use data from / to: sets the range of dates (), within which the Measurements are included in 

report. 

• Include Sub results: by default, Measurement Sub results are not presented in the Filtered Basic 

report format; click the check box () to include them. 

• Include Limits: by default, Measurement Limits are not presented in the Filtered Basic report 

format; click the check box () to include them. By including the Limits, including of Sub results is 

set by default. 

• Confirm the settings to open the Test project Filtered Basic report document in the Preview 

manager window. 

 

 
 

Figure 9.6: Setting window of Filtered Basic report 
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10 Creating Reports 

10.1  Creating Reports 

Metrel ES Manager supports comprehensive test reports that consist of inspection pages and test result 

pages. Reports are Data structure forms, based on predefined templates according to national standards or 

the rules of regulatory organisations. Created reports are saved in the reports subdirectory of the Data 

structure file. Printing and PDF creating functionality of the Reports depends on the instrument  licence key 

privileges. Each preformed measurement is equipped with meta-data of the S/N of the instrument that 

performed the measurement. If a Report form is not licenced, it launches in demo mode within the Report 

creating wizard. An appropriate message appears at the right bottom of the wizard window. 

10.1.1 Creating new Reports Step by Step 

New Reports can be created from a Data structure file downloaded from the instrument with the report wizard 

in the Reports menu. The Report wizard is a step-by-step tool for completing the final report in a "what you 

see is what you get" manner. Each page of the report is shown with a click on the Next button to navigate. On 

the pages some fields are filled in advance with measurements and other fields are filled manually. Fields 

which must contain addresses and dates have drop down menus with pre-stored addresses in the Database 

Tab or calendar for dates. 

NOTE: 

By default, automatic Reports page numbering is active. 

Uncheck the  field in the General tab of the Main tab Settings menu, if manual page 

numbering is required for Reports. The new setting will be permanently stored. 

10.1.1.1 Select Report Format 

The user can select a pre-prepared Report form: 

• Open a test project Data structure file and within the Tree view, select an appropriate structure 

element for which the test Report should be created. Reports that can be created from the 

corresponding structure elements are appropriately marked. 

• Click on the  icon within the Reports group of the Home menu tab to open a Report form 

selector dialog box, Figure 10.1. 

• : By default, the Date filter is not active, all measurements are included in the 

Report. Check the Filter box and set a date period to include only the 

Measurements performed within the selected date period. 

• Select a Report form from the list and click on the  button in the Report selection box. 

The selected Report form is opened in the Report Wizard Editor Screen for editing. 

• Clicking on the arrow next to the Report button offers additional options: Create PDF 

report and Print report, both without further editing possibility. This is suitable for large data 

structures, editing of which can exceed PC RAM capacity. 
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NOTE: 

Available Report forms are presented in blue background and depend on the properties of the selected Data 

structure object. In addition to the Report form name, available number of Licenced reports and available 

number of All Reports are presented. 

Licenced:0 mean that there are insufficient licence privileges and the Report can be presented in demo mode 

only. 

If number following All: is >1, it means that the subtree structure of the selected object contains more than 

one object. For each, an individual report is created. The same applies, if more than one object is selected 

within the Data structure. 

 

Figure 10.1: Report form selector box 

10.1.1.2 Report Wizard Editor Screen 

The selected Report form is opened in the Report Wizard Editor Screen, presented on Figure 10.2: 

Editing options which are selectable from menu at the top of the page are: 

• Commands organized in Groups are available at the top of Report wizard screen (). 

• Report form page layout (). 

• Page selector (): You can choose which pages you want to view, print or save to pdf. 

• Database list buttons (): click to open a Database list to enter data to the nearest field. 
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Figure 10.2: Report Wizard Editor Lookout 

10.1.1.3 Check and Fill Report Pages 

All pages are like an original report and are shown in "what you see is what you get" style. 

Navigation through the Report form: 

At every step you can go one page back or one page forward, to the end or to the beginning of the document 

using commands from the Navigation group. 

Select the page from Page selector to jump to the desired page. 

User data entry: 

The user can click on every field on the page and modify it. 

Click on buttons on the left side of the page to open a Database list associated with the nearest field. 

The following figure shows how to, after click to date field, pick a date from the calendar () and select an 

address from the database (). 

 

 
 

Figure 10.3: Pick a date from calendar and select an address from the database example 

 

Measurements data: 

Data structure file Measurements downloaded from Metrel instruments () and ticks () are automatically 

filled in the table. 
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Figure 10.4: Measurements with results are automatically filled in the report 

10.1.2 Exporting or printing final report 

After completing all pages, the user can choose the preferred output format of the final report. Available 

options are: 

 

• : Save: Save the Report under same name within the Data structure file. 

 

•  Save as - Save the Report under a different name within the Data structure file. 

 

• : Export to template: Save the Report to the selected folder as an external template 

file (*.rtmpl) to be used for report creation on other Data structure files in the same work scope region. 

 

• : Printing the report. 

 

• : Export the Report in PDF format. The user is prompted to select a folder and the file name. 
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10.1.3 Pro Export to Excel file format 

The Pro Export function enables data exporting from Test project Data structure files to an Excel table for 

further processing. 

Availability of the Pro export function depends on the instrument  licence key privileges. 

basic licence do not allow executing the Pro export function. 

The Pro export function is accessed from the drop-down menu of the ES Manager Main tab, as presented in 

Figure 10.5. It is active only when Test project Data structure file is opened. 

A user can select the range of objects for which the data will be exported to an Excel spreadsheet. With the 

selection of an object within the Data structure tree, only the data of the selected object and it  subtree 

objects and associated measurements data will be exported. With selection of the structure object Node, a 

complete Data structure will be exported. 

 

 
 

Figure 10.5: Pro export function selection menu 

 

The user can select between four basic Excel table column layouts options: 

• Measured values for objects: user selectable data is limited to Measurement data. 

• Inspection data: user selectable data is limited to Inspections data. 

• General structure data: user selectable data is limited to Structure data. 

• Complete data: all Measurements, Inspections and Structure data can be selected by the user. 

After the table layout is selected, a preview appears in an Export form window, presented in Figure 10.6. 

 

 

Note 
Printing the report directly to a printer may not work for some older printer 

models. In Such case choose print to PDF. A PDF version will be created and can 

be printed using the Adobe® Acrobat reader®, available from 

[http://get.adobe.com/uk/reader]. 

 

http://get.adobe.com/uk/reader
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Figure 10.6: Export form table data content preview window 

 

Export form window options offered to the user are: 

• Table data content preview area (). 

• Data tabs - User data column selection checkboxes organized in tabs (). 

• Function buttons (). 

• Command strip (). 

 

Table data content preview area 
Test measurement data appears in a separate row for each single test appended to the objects within the 

selected Data structure tree. By default, the following data columns are offered: 

• Path: Description of the Data structure path to the tested object. 

• Type: Type description of the Objects within the path. 

• Auto Sequence®: Name of the Auto Sequence® appended to the test object. 

• Measurement: Single test name. 

• Comment: Comment added to the test. 

• Status: Status of the single test. 

• User: Instrument username. 

• Serial: Instrument  serial number. 

• Firmware version: Instrument  firmware version. 

• Calibration date: Instrument  calibration date. 

The user can add additional data columns with the selection of checkboxes within the Data tabs. 

 

Data tabs 
The user can add custom selected data columns to the default table with the selection of a checkbox in front 

of the Data name listed within the three groups of Data tabs: 

• Structure objects 

• Measurements 

• Inspections 

Data is selected with click on the empty square checkbox in front of the Name of the data. The selection is 

marked with a tick. To un-select data, click on the square with the tick in front of it again. 
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When data common with other objects or measurements is selected, it appears selected for all objects and 

measurements. If a selection of such data is cleared, a warning message 'Duplicates were found' appears. 

The user should confirm the un-selection of data within all objects and measurements. 

A triangle in front of the data checkbox represents, that sub data for an individual selection exists. Click on 

the triangle to open a sub data list. Click on the sub data checkbox to select it. The upper level data checkbox 

appears filled with blue colour representing, that only a part of the sub data is selected. Select the checkbox 

on the upper level to select all sub data. 

 

Function buttons 

 Save filter: After custom selection of export data columns is finished, the user can save the 

selection as a filename.filter  file. Clicking on the Save filter button opens a browser, where the user can 

select the save folder and define the file name. 

 Load filter: Saved data columns filter can be loaded to other Data structure files to achieve 

the same user data export selection. Clicking on the Load filter button opens a browser, where the user 

can browse to the folder with the saved filter files and select the appropriate one. Only one filter file can 

be applied at the same time. Loading of another filter file will overwrite the previous filter file data. 

 Check all: Selects all available user selectable data for export. 

 Uncheck all: Clear all user selections of the data to be exported. 

 

 

 to Excel: After all user defined data for export is selected, click on the button within the 

command strip to create an Excel file. A browser is opened, where the user can select the save folder 

and define the file name. 

10.2 Creating Web Reports 

User can create, manage and archive Reports of Test project measurements with WebReports application. 

The application is a part of the Metrel Ecosystem platform, using the same user repository as Metrel Cloud. 

Before first use, new user must first register Metrel Cloud account and then enter WebReports License key 

to Cloud account. 

WebReports application is available only when Work scope Photovoltaic Region / PV testing is selected from 

Home tab Setting menu. 

For an easy start different pre-defined report templates are offered by Metrel. They can be used as they are 

or be modified and used as personal templates. The tool enables to create customized reports suited to 

one's personal demands. New templates can be made from scratch. 

WebReports templates are accessed from Metrel ES Manager Home tab Reports menu: 

• : Web Report command is active when Data structure file with appended 

measurements is opened. 

o Option: Data structure file was opened from storage location other than Cloud: 

browser is opened first to navigate and save Data structure file to Cloud folder. 
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o Option: Data structure file was opened from Cloud storage: 

Report Selector window with available list of graphic Report template files is opened, see 

Figure 10.7. A convenient tool is available to search for pre-made Report template. 

 

 
 

Figure 10.7: Report Selector window with Find tool opened 

 

Command options: 

• : Select appropriate Report graphic template and confirm. WebReports editor is 

opened. 

• : Dismiss Report Selector window 

 

Refer to WebReports User Manual for details on how to create templates and edit, manage and archive 

reports. 
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11 Manage Reports 

11.1 Manage Reports 

Manage Reports tool from the Reports tools group of the Home menu tab is available, when a Data structure 

file is opened. All previously created and saved reports associated with the opened Data structure file 

can be managed: 

 

•  : Clicking on the icon opens a list of existing reports (Figure 11.1) for managing. Each report 

can be opened for editing, deleted, or re-created (): 

o : Delete Report 

o : Open Report 

o : Re-create Report (Update with new data from a file) 

• : Refresh list of existing Reports 

 

 

Figure 11.1: Manage reports window 

11.2 Re-create Reports 

All existing or saved reports can be re-created via the Re-create button. Re-creation of a report updates the 

selected report with new data from the opened Data structure file. All earlier data in the report that was not 

updated remains unchanged. 

• Recreate Report: Clicking on the icon within a row of the Report to be re-created opens a 

warning message first, see Figure 11.2: 

o Some data can be modified or overwritten: After new downloading of the Data structure file 

from the instrument, recreated Report is refreshed with new test data; confirm to continue. 

o Next, the user is asked to set the . Select YES and set the date 

period and confirm or select NO to continue. 
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• A re-created report form is opened in the Report Wizard Editor Window. To perform further necessary 

editing of the report fields, save it or export it as a template. 

 

 

Figure 11.2: Re-create reports 
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12 Report Templates 

12.1 Editing Report Templates 

Report templates ("*.rtmpl" file) are generated from Create Report wizard by using 'Export to template' 

Report export option. These external Report templates can be used for report creation on other Data structure 

files (Projects) in the same work scope region. 

A template editor is available from the Tools group of the Home tab menu: 

• : Opens a browser to navigate to the Report template files folder location on the PC. 

The selected Report template file (*.rtmpl) is opened in the Report template editor window, Figure 

12.1: 

o Commands are available at the top of the Report Template editor screen (). 

o Page selector (): each Report Template page can be selected for layout presentation on the 

screen. 

o Report Template page layout (). 

o Database list buttons (). 

• Navigation through the Report Template: 

o At every step you can go one page back or one page forward, to the end or to the beginning of 

the document using the commands from the Navigation group. 

o Select a page within Page selector to jump to the desired page. 

• User data entry: 

o The user can click on every field in the page and modify it. 

o Click on the buttons on the left side of the page to open the associated Database list. 

• : Save: Save the Report Template under same name. 

•  Save as: Save the Report Template under a different name. 

 

 

Figure 12.1: Report Template Editor 
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12.2 Using Report Templates 

Saved templates can be used with the Create from template option from the Reports group of the Main tab 

menu. When a Data structure is opened, the following options are available: 

• : Opens a browser to navigate to the external Report Template file folder. Select 

one template file and click Open. 

• An information window appears. The user is asked to filter the data with a F

opening. Select YES and set the date period and confirm, or NO to continue. 

• A report Template is opened in the Report Wizard Editor Screen: 

o Measurements associated with the measurements within the opened Data structure are 

updated, other measurements are added to the Report. 

o Other previous data remains unchanged. 

o Data structure form remains the same and cannot be changed. 

o User editable fields can be edited. 

• Created Report can be Saved or Exported as a template. 

• Created Report can be printed to a PDF file format or directly to a Printer. 
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13 Troubleshooting 

13.1 Introduction to troubleshooting 

This chapter contains information that might be helpful if you encounter problems while working with Metrel 

ES Manager. If you don't find the help required to troubleshoot your problems, you can contact us directly. 

Check the Online support information for information on how to reach us. 

Your comments will help us improve our product and update the manuals with any necessary information. 

13.2 Instrument connection troubleshooting 

     

Figure 13.1: Instrument hardware connection and driver error message 

 

If the instrument is switched on and it settings are configured correctly, and the communication still does 

not work, please check the following: 

• Make sure that the cable is not broken and that the connectors are inserted properly. 

• Check that correct PC COM port is selected 

• Make sure that you close all other applications that might be using the port. You can also try 

restarting Windows and the instrument connected to make sure that all such applications are closed. 

• If none of this helps, there might be a problem with the device driver for the port you are using. You 

could try to reinstall or repair the Metrel ES Manager to make sure that your USB drivers are up to 

date. 

13.3 Reporting problems to Metrel 

This section deals with unexpected problems, errors and exceptions that may occur during usage of Metrel 

ES Manager. If you have encountered an error while using Metrel ES Manager, the best thing to do is to report 

this issue to your local distributer. 

13.3.1 Bug report checklist 

This section contains a brief list of items which your bug report should contain. For detailed information 

about each step, consult the next section. 

Regardless of the problem you are reporting, the minimum amount of information we need is: 

• A short description of the problem and, most importantly, steps needed to reproduce it. 

• Metrel ES Manager log file (located in the C:\Program Files (x86)\Metrel\MESM\logs folder). 

Error log file (located in the C:\Users\%userprofile%\AppData\Roaming\IonSeriLog\Ion.Translator folder). 
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14 Online support information 

14.1 How to get support? 

14.1.1 Contact your local distributer! 

Most issues can be solved by your local distributor. This support is accessible in your local language. Find the 

closest distributor here: https://www.metrel.si/en/locations/  

14.1.2 Contact us directly 

Metrel d.o.o.Slovenia 

Ljubljanska cesta 77 

Horjul, SI-1354 Slovenia 

Phone: +386 1 7558 200 

Fax: +386 1 7549 226 

E-mail: support@metrel.si  

 

Web site: www.metrel.si [http://www.metrel.si/] 

14.1.3 Use the online contact form 

You can also contact us using our Contact form [https://www.metrel.si/en/contact/]. This web page also 

contains a map of our distributer network and a route to Metrel Company's headquarters. 

 

https://www.metrel.si/en/locations/
mailto:metrel@metrel.si
http://www.metrel.si/
http://www.metrel.si/company/contacts.html
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Appendix A Instrument Work scope mapping table 

Work Scope Region Profile / Instrument 

Safety of Electrical Equipment I Machine, Switchgear and PAT testing EU AUAA [MI 3325 EU] 

Safety of Electrical Equipment I Machine, Switchgear and PAT testing EU AUAJ [MI 3325 DEU] 

Safety of Electrical Equipment I Machine, Switchgear and PAT testing UK AUAB [MI 3325 UK] 

Safety of Electrical Equipment I Machine, Switchgear and PAT testing AUS, NZ AUAD [MI 3325 AUS] 

Safety of Electrical Equipment I Machine, Switchgear and PAT testing Hungarian AUAE [MI 3325 HUN] 

Safety of Electrical Equipment I Machine, Switchgear and PAT testing Austrian AUAF [MI 3325 AUT] 

Safety of Electrical Equipment I Machine, Switchgear and PAT testing Finnish AUAG [MI 3325 FIN] 

Safety of Electrical Equipment I Machine, Switchgear and PAT testing Russian AUAH [MI 3325 RUS] 

Safety of Electrical Equipment I PAT (new instruments) CBAB [MI 3340 ANG] 

Safety of Electrical Equipment I PAT (new instruments) CBAC [MI 3340 UK] 

Safety of Electrical Equipment I PAT (new instruments) CBAD [MI 3340 AUS] 

Safety of Electrical Equipment I PAT (new instruments) AOAB [MI 3360 ANG] 

Safety of Electrical Equipment I PAT (new instruments) AOAC [MI 3360 F ANG] 

Safety of Electrical Equipment I PAT (new instruments) AOAD [MI 3360 M ANG] 

Safety of Electrical Equipment I PAT (new instruments) AOAE [MI 3360 25A ANG] 

Safety of Electrical Equipment I PAT (new instruments) AOAG [MI 3360 UK] 

Safety of Electrical Equipment I PAT (new instruments) AOAH [MI 3360 F UK] 

Safety of Electrical Equipment I PAT (new instruments) AOAI [MI 3360 M UK] 

Safety of Electrical Equipment I PAT (new instruments) AOAF [MI 3360 25A UK] 

Safety of Electrical Equipment I PAT (new instruments) AOAN [MI 3360 DEU] 

Safety of Electrical Equipment I PAT (new instruments) AOAO [MI 3360 F DEU] 

Safety of Electrical Equipment I PAT (new instruments) AOAP [MI 3360 M DEU] 

Safety of Electrical Equipment I PAT (new instruments) AOAQ [MI 3360 25A DEU] 

Safety of Electrical Equipment I PAT (new instruments) AOAK [MI 3360 AUS] 

Safety of Electrical Equipment I PAT (new instruments) AOAL [MI 3360 F AUS] 

Safety of Electrical Equipment I PAT (new instruments) AOAM [MI 3360 M AUS] 

Safety of Electrical Equipment I PAT (new instruments) AOAJ [MI 3360 25A AUS] 

Safety of Electrical Equipment I PAT (new instruments) EFAB [MI 3365 ANG] 

Safety of Electrical Equipment I PAT (new instruments) EFAC [MI 3365 F ANG] 

Safety of Electrical Equipment I PAT (new instruments) EFAD [MI 3365 M ANG] 

Safety of Electrical Equipment I PAT (new instruments) EFAE [MI 3365 25A ANG] 

Safety of Electrical Equipment I PAT (new instruments) EFAF [MI 3365 AUS] 

Safety of Electrical Equipment I PAT (new instruments) EFAG [MI 3365 UK] 

Safety of Electrical Equipment I PAT (new instruments) EFAH [MI 3365 F AUS] 

Safety of Electrical Equipment I PAT (new instruments) EFAI [MI 3365 F UK] 

Safety of Electrical Equipment I PAT (new instruments) EFAJ [MI 3365 M AUS] 

Safety of Electrical Equipment I PAT (new instruments) EFAK [MI 3365 M UK] 

Safety of Electrical Equipment I PAT (new instruments) EFAL [MI 3365 25A AUS] 

Safety of Electrical Equipment I PAT (new instruments) EFAM [MI 3365 25A UK] 

Safety of Electrical Equipment I PAT (new instruments) EFAN [MI 3365 DEU] 

Safety of Electrical Equipment I PAT (new instruments) EFAO [MI 3365 F DEU] 
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Safety of Electrical Equipment I PAT (new instruments) EFAP [MI 3365 M DEU] 

Safety of Electrical Equipment I PAT (new instruments) EFAQ [MI 3365 25A DEU] 

Safety of Electrical Equipment I PAT (new instruments) EFAR [MB 3365 DEU] 

Safety of Electrical Equipment I PAT (new instruments) EFAS [MB 3365 F DEU] 

Safety of Electrical Equipment I PAT (new instruments) EFAT [MB 3365 M DEU] 

Safety of Electrical Equipment I PAT (new instruments) EFAU [MB 3365 25A DEU] 

Safety of Electrical Equipment II Production Line Testing ANAA [MI 3394 ANG] 

Safety of Electrical Equipment II Production Line Testing ANAB [MI 3394 DEU] 

Safety of Electrical Equipment II Production Line Testing ANAD [MI 3394 POL] 

Safety of Electrical Equipment II Production Line Testing ANAC [MI 3394 ESP] 

Safety of HV Installations Transformer APAA [MI 3280 ANG] 

Safety of HV Installations Transformer AKAB [MI 3281 ANG] 

Safety of HV Installations Protective Earthing ARAD [MI 3290 X] 

Safety of HV Installations Protective Earthing ARAB [MI 3290 GF] 

Safety of HV Installations Protective Earthing ARAA [MI 3290 GL] 

Safety of HV Installations Protective Earthing ARAC [MI 3290 GP] 

Safety of HV Installations Protective Earthing ARAF [MI 3290 GH] 

Safety of HV Installations Protective Earthing ARAE [MI 3290 G] 

Safety of HV Installations Protective Earthing AXAA [MI 3295M - EU] 

Safety of LV Installations UK Installations ALAB [MI 3152 UK] 

Safety of LV Installations EU Installations ALAA [MI 3152 ANG] 

Safety of LV Installations EU Installations ALAI [MI 3152 CHE] 

Safety of LV Installations EU Installations ALAK [MI 3152 DEU] 

Safety of LV Installations EU Installations ALAM [MI 3152 DNK] 

Safety of LV Installations EU Installations ALAN [MI 3152 SVN] 

Safety of LV Installations EU Installations ALAO [MI 3152 POL] 

Safety of LV Installations EU Installations ALAP [MI 3152 CZE] 

Safety of LV Installations EU Installations ALAR [MI 3152 NLD] 

Safety of LV Installations EU Installations ALAS [MI 3152 SVK] 

Safety of LV Installations EU Installations ALAV [MI 3152 ISR] 

Safety of LV Installations French Installations ALAG [MI 3152 FRA Sefram] 

Safety of LV Installations AUS/NZ Installations ALAT [MI 3152 NZL] 

Safety of LV Installations AUS/NZ Installations ALAU [MI 3152 AUS] 

Safety of LV Installations Hungarian Installations ALAD [MI 3152 HUN] 

Safety of LV Installations Austrian Installations ALAJ [MI 3152 AUT] 

Safety of LV Installations Finnish Installations ALAC [MI 3152 FIN] 

Safety of LV Installations Russian Installations ALAL [MI 3152 RUS] 

Safety of LV Installations EU Installations AMAA [MI 3152H ANG] 

Safety of LV Installations EU Installations AMAD [MI 3152H CHE] 

Safety of LV Installations EU Installations AMAE [MI 3152H POL] 

Safety of LV Installations EU Installations AMAC [MI 3152H CZE] 

Safety of LV Installations EU Installations AMAF [MI 3152H SVK] 

Safety of LV Installations Russian Installations AMAB [MI 3152H RUS] 

Safety of LV Installations UK Installations ATAB [MI 3155 UK] 

Safety of LV Installations EU Installations ATAA [MI 3155 ANG] 
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Safety of LV Installations EU Installations ATAJ [MI 3155 CHE] 

Safety of LV Installations EU Installations ATAO [MI 3155 DNK] 

Safety of LV Installations French Installations ATAI [MI 3155 FRA] 

Safety of LV Installations AUS/NZ Installations ATAK [MI 3155 NZL] 

Safety of LV Installations AUS/NZ Installations ATAC [MI 3155 AUS] 

Safety of LV Installations Hungarian Installations ATAG [MI 3155 HUN] 

Safety of LV Installations Austrian Installations ATAF [MI 3155 AUT] 

Safety of LV Installations Finnish Installations ATAH [MI 3155 FIN] 

Safety of LV Installations Russian Installations ATAD [MI 3155 RUS] 

Safety of LV Old_Installations Installations (old instruments for UK) AEAB [MI 3100 SE - UK1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) AEAA [MI 3100 SE - ANG1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) AEAD [MI 3100 SE - CZE1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) AEAE [MI 3100 SE - NLD1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) AEAL [MI 3100 SE - NLD2] 

Safety of LV Old_Installations Installations (old instruments, standard versions) AEAG [MI 3100 SE - GRC] 

Safety of LV Old_Installations Installations (old instruments for D, CH) AEAF [MI 3100 SE - CHE1] 

Safety of LV Old_Installations Installations (old instruments for AUS/NZ) AEAJ [MI 3100 SE - NZL1] 

Safety of LV Old_Installations Installations (old instruments for Hungary) AEAI [MI 3100 SE - HUN1] 

Safety of LV Old_Installations Installations (old instruments for Finland) AEAM [MI 3100 SE – FIN] 

Safety of LV Old_Installations Installations (old instruments, Russian versions) AEAC [MI 3100 SE - RUS1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) AFAC [MI 3100B SE - ITA1] 

Safety of LV Old_Installations Installations (old instruments for D, CH) AFAB [MI 3100B SE - CHE1] 

Safety of LV Old_Installations Installations (old instruments for D, CH) AFAA [MI 3100B SE - DEU1] 

Safety of LV Old_Installations Installations (old instruments for AUS/NZ) AFAE [MI 3100B SE - NZL1] 

Safety of LV Old_Installations Installations (old instruments for UK) ABAB [MI 3102 BT - UK1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) ABAA [MI 3102 BT - ANG1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) ABAJ [MI 3102 BT - GRC1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) ABAD [MI 3102 BT - NLD1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) ABAE [MI 3102 BT - CZE1] 

Safety of LV Old_Installations Installations (old instruments for D, CH) ABAG [MI 3102 BT - CHE1] 

Safety of LV Old_Installations Installations (old instruments for France) ABAI [MI 3102 BT - FRA1] 

Safety of LV Old_Installations Installations (old instruments for AUS/NZ) ABAC [MI 3102 BT - NZL1] 

Safety of LV Old_Installations Installations (old instruments for Hungary) ABAO [MI 3102 BT - HUN1] 

Safety of LV Old_Installations Installations (old instruments for Austria) ABAM [MI 3102 BT - AUT1] 

Safety of LV Old_Installations Installations (old instruments for Finland) ABAK [MI 3102 BT - FIN] 

Safety of LV Old_Installations Installations (old instruments for UK) ACAB [MI 3102H BT - UK1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) ACAA [MI 3102H BT - ANG1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) ACAE [MI 3102H BT - LTU1] 

Safety of LV Old_Installations Installations (old instruments, standard versions) ACAH [MI 3102H BT - ESP] 

Safety of LV Old_Installations Installations (old instruments, standard versions) ACAD [MI 3102H BT - CZE1] 

Safety of LV Old_Installations Installations (old instruments for D, CH) ACAF [MI 3102H BT - CHE] 

Safety of LV Old_Installations Installations (old instruments for Hungary) ACAG [MI 3102H BT - HUN1] 

Safety of LV Old_Installations Installations (old instruments, Russian versions) ACAC [MI 3102H BT - RUS1] 

Safety of LV Old_Installations Installations (old instruments, Russian versions) ADAA [MI 3102H SE - RUS1] 

Safety of LV Old_Installations Installations (old instruments, EU versions) BEAA [MI 3108 PV - EU] 
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Safety of LV Old_Installations Installations (old instruments, UK versions) BEAB [MI 3108 PV - UK] 

Safety of LV Old_Installations Installations (old instruments, D, CH versions) BEAC [MI 3108 PV - SVICA] 

Safety of LV Old_Installations Installations (old instruments, AU versions) BEAD [MI 3108 PV - AUS] 

Safety of LV Old_Installations Installations (old instruments, FR versions) BEAE [MI 3108 PV - FRA] 

Safety of LV Old_Installations Installations (old instruments, HU versions) BEAF [MI 3108 PV - HUN] 

Safety of LV Old_Installations Installations (old instruments, AT versions) BEAG [MI 3108 PV - AUT] 

Safety of LV Old_Installations Installations (old instruments, FIN versions) BEAH [MI 3108 PV - FIN] 

Safety of LV Old_Installations Installations (old instruments, RU versions) BEAI [MI 3108 PV - RUS] 

Safety of LV Old_Installations Installations (old instruments, EU versions) BFAA [MI 3109 PV Lite - EU] 

Safety of LV Old_Installations Installations (old instruments, UK versions) BFAB [MI 3109 PV Lite - UK] 

Safety of LV Old_Installations Installations (old instruments, AU versions) BFAC [MI 3109 PV Lite - AUS] 

Safety of LV Old_Installations Installations (old instruments, D, CH versions) BFAD [MI 3109 PV Lite - DEU] 

Safety of LV Old_Installations Installations (old instruments, FR versions) BFAE [MI 3109 PV Lite - FRA] 

Safety of LV Old_Installations Installations (old instruments, HU versions) BFAF [MI 3109 PV Lite - HUN] 

Safety of LV Old_Installations Installations (old instruments, AT versions) BFAG [MI 3109 PV Lite - AUT] 

Safety of LV Old_Installations Installations (old instruments, FIN versions) BFAH [MI 3109 PV Lite - FIN] 

Safety of LV Old_Installations Installations (old instruments, RU versions) BFAI [MI 3109 PV Lite - RUS] 

Safety of LV Old_Installations Installations (old instruments for UK) AJAC [MI 3125 BT - UK2] 

Safety of LV Old_Installations Installations (old instruments, standard versions) AJAB [MI 3125 BT - DNK1] 

Safety of LV Old_Installations Installations (old instruments for D, CH) AJAJ [MI 3125 BT - CHE4] 

Safety of LV Old_Installations Installations (old instruments for D, CH) AJAA [MI 3125 BT - DEU1] 

Safety of LV Old_Installations Installations (old instruments for AUS/NZ) AJAN [MI 3125 BT - AUS3] 

Safety of LV Old_Installations Installations (old instruments for Austria) AJAS [MI 3125 BT - AUT] 

Safety of LV Old_Installations Installations (old instruments for D, CH) AIAM [MI 3125B - CHE2] 

Safety of LV Old_Installations Installations (old instruments for D, CH) AIAD [MI 3125B - DEU2] 

Safety of LV Old_Installations Installations (old instruments for D, CH) AIAK [MI 3125B - DEU5] 

Safety of LV Old_Installations Installations (old instruments for D, CH) AIAL [MI 3125B - DEU6] 

Safety of LV Old_Installations PAT (old instruments, standard versions) AQAA [MI 3309 BT ANG1] 

Safety of LV Old_Installations PAT (old instruments, standard versions) AQAF [MI 3309 BT UK1] 

Safety of LV Old_Installations PAT (old instruments, standard versions) AQAD [MI 3309 BT CHE1] 

Safety of LV Old_Installations PAT (old instruments, standard versions) AQAH [MI 3309 BT CZE1] 

Safety of LV Old_Installations PAT (old instruments for AUS/NZ) AQAG [MI 3309 BT NZL1] 

Industry General AYAB [MI 3211 ANG] 

Industry General BHAB [MI 3215 ANG] 

Industry Industry AVAB [MI 3288 EI] 

Photovoltaic PV testing EEAB [MI 3114 ANG] 

Photovoltaic PV testing BBAB [MI 3115 ANG] 

Photovoltaic PV testing BJAB [MI 3116 ANG] 

Vehicles EV CDAB [MI 3132 ANG] 
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Appendix B PV Post Processing Analysis 

PV Post Processing Analyse is an extension of Metrel ES Manager and is intended for deeper analysis of I/U 

characteristics of PV modules and strings. 

B.1  

After the Data structure file with finished PV test measurements is opened, position mouse pointer on the 

structure element with I/U measurement and apply right click. When menu window appears on the screen, select 

PV/Post processing analyse command (see Figure B.1) to automatically open Post Processing Analyse window. 

 

 

Figure B.1: Post Processing Analyse opening command 

 

B.2  

Post Processing Analyse window is presented on Figure B.2. The results are presented in graphical form at the top 

of the window and numerical form in the table beneath. On the left, Module data, Instrument data, Results, 

Environmental conditions and values for STC calculation are listed. At the header row is a command for opening 

PV module database. 

Actions, which can be performed, are: 

• Analysis of graphical representation of the measured I/U and power characteristic of the module or 

string. 

• Checking and setting of some parameters needed for STC calculations. 

• Replacing the module data with data from private or public module DB. 
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• Maintenance of private module DB. 

 

 

Figure B.2: Post Processing Analyse window 

B.2.1  Graphical analysis of I/U characteristic and Power graph 

Module or string results are presented in the graph, see Figure B.3. Presented curves of different colours are: 

•  Nominal I/U characteristic 

•  Measured I/U characteristic 

• The STC I/U characteristic 

• Nominal Power characteristic 

• Measured Power characteristic 

• The STC Power characteristic 

 

 

Figure B.3: I/U characteristic and Power graph 

 

Click on slide bar handle and move vertical bar within graph to the interested X-axis voltage position. Values listed 

left of the curve colour marks represent values at the cross section with vertical bar. 
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B.2.2  Numerical Analysis 

The final results are listed in the STC (Standard Test condition) table, see Figure B.4. 

 

 

Figure B.4: STC table 

 

Data listed in columns under STC header are: 

• Manufacturer data: Data for one module and for the measured string are listed. 

• Calculated values: STC values of the module and string. 

• Deviation: Deviations between STC results and manufacturer data are listed. 

• PASS/FAIL criteria: The comparison results are also represented as Pass/Fail semaphores with two user 

defined threshold levels. To modify this levels just modify the values in the % fields. 

B.3  

PV Post Processing Analyse extension provides tools for changing parameters after test is finished. User can 

change: 

• Ambient data: 

 

• PV module data and array structure: it often happens that at the time of measurement all the needed 

technical information about the PV installation is not available. 

• Temperature coefficients: This data are also not always available when performing the measurement. 

The problem is also that the manufacturers provide this data in two different forms: in absolute or in 

relative form. Here you can enter the correct value in one of both forms. 

STC calculation is then performed with these changed values. 

, see Figure B.5. 

 

 

Figure B.5: Measurement results table 
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B.3.1 Changing Ambient Data and PV Array data 

Ambient data and PV Array data are presented in table Measurement conditions, see Figure B.6. Squares on the 

left side of the table present fields for manual data entry. In the presented table, number of modules in string 

was manually corrected. 

 

 

Figure B.6: Measurement conditions table 

B.3.2 Module data change 

Module coefficients and serial resistance are presented in table Manufacturer data table, see Figure B.7. Squares 

on the left side of the table present fields for manual data entry. 

 

 

Figure B.7: Manufacturer data table 

B.3.3 Parameters for STC calculation 

The final values as used for the STC calculation are listed in the Used parameters for STC calculation table, see 

Figure B.8. Manually entered values and parameters are preferentially used for STC calculation. 

 

 

Figure B.8: Used parameters for STC calculation table 

 

After each parameter manual entry, all STC table data are promptly recalculated and updated and presented in 

I/U characteristic and Power graph also. 
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Three values for module serial resistance (Rs) are available, if all entered. Below are listed in priority order used for 

STC calculation: 

1. Manually entered value 

2. Measured value 

3. Value from manufacturer data 

B.4  

PV module name and test instrument data are presented in the table at the left-top of the PV Post Processing 

Analyse window, see Figure B.9. 

 

 

Figure B.9: Module and Instrument data table 

 

limited to 14 characters and must be 

 

 

PV module DB handling window provides tools to perform following actions: 

• Review of test project module data 

• Save test project module data to Private DB 

• Replace test project module with another one from Private DB or Public DB 

 

Opening PV module database handling window: 

•  Click database icon within header to open Save and Find database data window, see Figure B.10. 

 

Save and Find database data window contains two sub-windows: 

• Database Related Information with switch between Public database and Private database on the left. 

• Module data review on the right, with database handling commands at the bottom. 

 

Test project module data review:  

By default, after Save and Find database data window is opened, test project module name and it related detailed 

data are listed in Module data sub-window. 

 

: Save module data to Private DB.  

Before saving, test project module can be renamed and any of related data can be changed. If module with same 

name already exist in DB, warning message appear on the screen and user must confirm replacement of existing 

parameters or cancel operation. 
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: Import selected module to the PV Post Processing Analyse extension 

Test project module data are replaced with Imported module data. User can select new PV module in Public DB or 

in Private DB. Selected module name and data are presented in Module data sub-window. Click on Import 

command and the selected module data are loaded and the recalculation to STC values is immediately executed. 

 

 

 

Figure B.10: PV Module database handling window 

 

: Close Save and find database data window. 
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Appendix C Excel to Metrel ESM file converter 
instructions 

C.1  

 

Figure C.1: Dashboard screen of web service wizard - fixed part 
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General Settings 

Enables basic settings for creation of .padfx files. 

Number of lines to skip from top Defines how many lines in the excel file will be skipped (starting, line 

1). 

Master Work scope Defines the master and child Work scope for created .padfx file. 

Correct Work scope must be selected in order to enable files transfer 

to the desired instrument. Child Work scope 

Structure objects Settings 

Enables the creation of a basic structure, where the structural elements with relevant data will be imported. 

Structure object type Enables selection of corresponding structural elements for the 

relevant structural level. 

Row Settings 

Enables to define data structure from excel file, to be linked to the corresponding parameters of the selected structural 

element.  

Parameter links 

Each configuration is corresponding to relevant column from source excel file. 

Parameter Enables selection of parameter linked to the corresponding structural 

element. Each parameter can be linked only to one column letter in 

the source excel file. 

Column letter Defines the column in the source excel file. 

Allow null or empty Defines criteria for specific cell.  

True = allows empty cells in specific column.  

False = forbids empty cells in specific column. 

Column type Defines criteria for specific cell.  

Text = cell data can contain letters, numbers, and special characters 

such as ! or &. 

Date & time = cell data shall be in following format dd.mm.yyyy 

hh:mm:ss. 

 Allows adding of the set parameters to the list. 

Load configuration Enables to load user configuration from file. 

Save configuration Enables to save set configuration to file. 

Select an excel file and start conversion Enables selection of source excel file, conversion to .padfx is started 

automatically if no exceptions are found.  
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Figure C.2: Dashboard screen of web service wizard - user defined part 

 

 

A field with user-set parameters, each section 

defines its own column in excel. 

 

Allows removal of specific section. 
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C.2  

First prepare the excel file, put the data into the correct format. Data shall be arranged in columns, all cells except 

dates shall be categorized as General. Cells containing dates shall be categorized as Date and formatted as 

dd.mm.yyyy. 

 

 

Figure C.3: Correlation between Excel & Parameter links 
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Figure C.4: Correlation between MESM, Excel, and Wizard 
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Figure C.5: Correlation between MESM & Wizard 
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